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CHAPTER

ONE

GETTING STARTED

1.1 System Requirements

Operating System Windows (7 or newer)
Architecture 64-bit (32-bit no longer supported)
Processor Intel Core 2 Duo 2.00 GHz (or equivalent)
RAM 8GB
Hard Drive Space 300 MB (not including projects)
Graphics Card OpenGL 3.0 - compatible
Java Runtime 1.8

Note: Pix2Net is an graphics-intensive program that is meant to be run locally. If you attempt to use it with remote
display software, such as NoMachine NX, Pix2Net is not guaranteed to be responsive (or even work).

1.1.1 Windows

Run the Windows installer. If this is the first time you are installing Pix2Net, make sure the Visual Studio
2010 redistributable, Java Runtime Environment 8, and the Sentinel HASP Run-time
packages are selected for installation.

After the installation, insert the security dongle into your computer. Launch Pix2Net by double-clicking the Pix2Net
shortcut on the desktop, or by going to Start → All Programs → Pix2Net → Pix2Net.

Troubleshooting

If you experience rendering issues while using Pix2Net (i.e. you see white squares where images are supposed to be),
try updating the drivers for your graphics card. To find out what driver you are currently using, open the Start menu,
type in dxdiag and hit Enter. Click Display 1, look at the Drivers group on the right, and note the Version
field. Then go to the appropriate website for your graphics card and make sure that you are using the latest version of
the driver:

• AMD/ATI

• Intel

• NVidia

• S3 Graphics
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Pix2Net Documentation, Release 1.10.07

2 Chapter 1. Getting Started



CHAPTER

TWO

GUIDED TOUR

2.1 Pix2Net Stage Installation

Before installation of the stage you’ll need to HOME the FIB/SEM stage. The HOME button can be found in the stage
tab of the FIB/SEM (HOME w/rotation).

1. After venting the FIB/SEM chamber, begin by removing the stage mount from the base of the FIB/SEM stage.
Safely store the stage mount

2. Attach the stage base plate to the FIB/SEM stage base using the three (3) hex bolts provided. You’ll need to
manually rotate the FIB/SEM stage so that red arrow on the base plate is pointing at FIB/SEM chamber entrance.
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3. Attach the stage to the recently installed base plate using the M2 bolts provided. There are two (2) bolts to
attach. Slide the stage left and drop in an M2 bolt to attach to base plate. Do not tighten fully as you will need to
slide stage to the right and will have to adjust the stage to drop in the 2nd M2 bolt. NOTE: as long as the stage
is powered off it is okay to manipulate it manually to get in the correct positions for the install.
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4. Attach the wire stress relief clip to the FIB/SEM stage. Set the stage wires to an appropriate length.

5. All stage wires should be attached to the FIB/SEM internally already but you should verify this before proceed-
ing. Motor 1 connects to Axis 1 (X): Motor 2 connects to Axis 2 (Y): Motor 3 connects to Axis 2 (Rotation)
of the green stage controller box. NOTE: we generally leave all wire connections intact and just store the stage
itself in the back of the FIB/SEM chamber when not being used.

6. Attach the extension stage mount (new extension) onto the rotation stage.

2.1. Pix2Net Stage Installation 5
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7. Attach and center your sample stage onto the new extension stage and then tighten your set screw to secure your
sample.

8. You may now connect the USB wire from the support computer and the power supply to the green controller
box. You will notice the lights on the back of the green controller box are red when first powered on. If your
connections are correct these lights will convert to green indicating that your setup is correct. If any lights
remain red, check your wire connections and retry until all lights are green.
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9. Before sealing the FIB/SEM chamber, check and make sure your sample is grounded properly using a multi-
meter (continuity).

10. Seal the FIB/SEM chamber and begin image acquisition. NOTE: make sure all wires are clear when sealing
FIB/SEM chamber.

2.1. Pix2Net Stage Installation 7
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2.2 Pix2Net Automation Operation

1. Be sure to check that there is enough space to store the project you will be working on. On the support CPU (cart)
you will want to check the C: drive. Before proceeding make sure the Pix2Net Stage Installation instructions
are read Pix2Net Stage Installation and performed correctly. All light indicators on the controller box should be
green.

2. Disconnect the long white network cable from the FEI support CPU and connect it to the bottom most port on
the MSI support CPU (cart). This will allow the SEM and support CPU (cart) to communicate through the Z:
drive. If the Z: drive is not active you will need to run a batch file to make it active. Located on the desktop of
the support CPU (cart) Z Drive.bat.

3. Open the Pix2Net software by clicking the icon on the desktop Pix2Net.bat. Create a new project or open a
recent project.

4. Click on the Capture tab and you will notice the header changes. Now click the stage icon and a drop menu
selection appears. (All settings for the SEM)

Type: Pix2Net/ w rotation

Axis Swap: Place a check mark in box

Port: Com 7

Cycle Power on Error: Place a check mark in box

Sense: Invert Y

Home on Connect: Place a check mark in box

5. After your parameters have been set connect the stage. It should begin a Homing procedure of the Pix2Net stage
that will take about a minute to complete.

6. Once the Homing procedure is complete, verify the stage moves as intended.

7. Begin the leveling and rotation of your sample. Using a sample feature such as a metal line that runs the entire
width of the sample is the best method. Start by using the XT align feature of the SEM to give you a straight
image in the SEM. It is located in the Stage tab of the SEM. Place the line or feature your using to level under
the center crosshair of the SEM. Using the Pix2Net stage move the sample in the X axis along the line you
are using to level. Generally use small movements(50um) to start and gradually move farther in the X axis as
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the sample becomes more level. Determine which direction the rotation needs to move in order to correct the
leveling(Clockwise or Counterclockwise). In adjusting the rotation of your sample the SEM image will need
rotation of the SEM to make the sample straight again. Repeat the XT align feature as needed.

8. Once a good alignment has been achieved, begin gathering the information required to get an entire imaging run
captured. All information can be stored and saved in the Capture config. window under the Capture tab. Record
the device name, device height, device width, magnification, accelerating voltage, brightness, contrast and the
scale.

9. To determine the scale of an imaging run, zoom to the magnification level you intend use and set the scan level
at 2us and freeze the image. Click on the file tab of the SEM and enter the image properties. Record the values
given under Pixel height and Pixel width and divide by 1000. Example: Mag/2000 – Pixel height / 72.85nm –
(1000/72.85= 13.726 pixels per micron) place this value in the scale window under the Capture Config tab of
the Pix2Net software.

10. The first Quad (upper left) of the imaging windows on the SEM is the image capture window. Most imaging
runs are shot under the backscatter detector (VCD) of the FIB. Set the first quad to the appropriate detector
(VCD or ETD). Begin adjusting contrast and brightness levels for the intended imaging run. Lines and Vias are
usually set as white as possible against a black back-round.

11. Begin connecting the SEM camera to the Pix2Net software. Minimize the SEM UI (user interface) and connect
to the Shortcut to Run Pix2Net Server.bat located on the SEM desktop. Large cmd window should open.

12. Once you have opened the server you may connect the SEM camera to the Pix2Net software. Begin by clicking
on the camera tab and a drop down menu appears. Select the camera you intend to use (microscope). Pix2Net
expects the SEM to be in a paused state prior to image acquisition.

13. Once connected the SEM camera will take a test image and then should be ready. The camera icon will let you
know when it is ready. Click on the camera ready tab to execute an image capture.

14. Make final adjustments needed for your imaging run. Verify your images will convert to GDS2 if required.
Make sure sample is within area you designated for the imaging run (check corners). Good idea to double check
that all values entered onto the capture config window are correct before any imaging run is started.

15. Click the Start tab to begin your run. Once the run has begun do not move the mouse on the SEM CPU
anymore. The Pix2Net software has taken control of the mouse and needs it pause and begin another image
capture. Disturbing the mouse will cause the camera to fail.

2.3 Setting Up Pix2Net Server

This tutorial will show you how to capture an image from a scanning electron microscope.

2.3.1 Install and Run the Pix2Net Server

Note To use Pix2Net, the user must have Java installed.

In order for Pix2Net to control the SEM, the Pix2Net Server application must be running on your SEM’s support
computer.

The Pix2Net server files are located in C:\Program Files\Pix2Net\server. Copy these files to a directory
on the SEM’s support machine, and then double-click RunPix2NetServer.bat. The Pix2Net Server application
should start up.

2.3. Setting Up Pix2Net Server 9
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The Pix2Net Server is now waiting for Pix2Net to connect to it on port 20038. You should also note the IP address of
the SEM’s support computer. You can obtain the IP address by typing ipconfig in a dos prompt.

2.3.2 Connect to the Pix2Net Server

1. Start Pix2Net and go to the Capture tab. Press the Setup Server button.

The Setup Server dialog should appear:
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2. Make sure the IP Address field matches the IP address of the machine the Pix2Net Server is running on.

3. Click the Add Profile button to add a new profile. Enter the name of your SEM (e.g. FIB).

If Pix2Net was able to connect to the server, then the Edit Profile window will appear, with a snapshot of
the SEM support computer’s desktop:

2.3. Setting Up Pix2Net Server 11
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To get back to the ‘‘Edit Profile‘‘ window, press on the pencil button in the ‘‘Setup Server‘‘ window.

2.3.3 Preparing the SEM

You need to begin by putting the SEM in a state where you can capture a test image. For example, you may want
to turn the beam on. You can do this from the Edit Profile window if you switch to interactive mode by pressing the
Interactive button.

In interactive mode, whenever you click somewhere on the image of the support computer, that mouse click will be
sent to the support computer, and the screen will be refreshed. It is similar to a Remote Desktop session, except the
screen will only be refreshed once after each mouse press.

Once you are ready to capture an image, you can start entering the necessary steps into Pix2Net.

2.3.4 Entering Steps

Your SEM is most likely different from ours, so you will need to come up with your own set of steps. However, for
the purposes of the following example, assume that you can capture an image with your SEM by pressing a Resume
button.

You must tell Pix2Net what the Resume button looks like, and where it is. You can accomplish this by adding a
resource.

1. Switch to the resource mode by pressing the Resource button.
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2. Draw a box around the Resume button by clicking and dragging. The box does not have to be perfect.

3. Enter a name, such as Resume Button, set the type to Fixed Image, and click Add.

By specifying Fixed Image, we are telling Pix2Net that it can assume that resume button will always be at exactly
the same place on the screen. If it is not safe for Pix2Net to make that assumption, then we could have specified
Floating Image. In that case, Pix2Net would scan the screen for the first set of pixels that match the image of the
resume button.

Another resource we will add at this time is a region that represents the Preview area. This is the area of the SEM’s
GUI that shows a preview of the area that will be captured.

1. Click and drag to draw a bounding box around the area of the GUI that shows a preview of the image to be
captured.

2. Enter a name, such as Preview, set the type to Region, and click Add.

By specifying Region, we are telling Pix2Net that this resource is purely a bounding box and not an image.

Now, let’s start creating the protocol (a set of mapping of commands to what actually happens on screen):

1. Click on the Protocols tab and then click the Add button.

2. Choose a name for the protocol, such as Standard, and click Ok. In general, you will only need one protocol.

3. You will now see a list of commands that can be defined. Select Capture Image.

2.3. Setting Up Pix2Net Server 13
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4. Click the New Step button, choose Press Mouse Button, and click Ok.

5. In the settings for Press Mouse Button, set the target area to the resource you defined for the resume
button.

6. Click the New Step button, choose Delay, and choose some amount of time for Pix2Net to wait for the image
to be captured.

7. Click the New Step button, choose Read Image, and enter the directory the image will be saved to. Pix2Net
will grab the latest .bmp file from this directory. The image will be deleted after reading by default, so that
Pix2Net does not accidentally read the same image again in a future image capture.

8. Select the Capture Preview command.

9. Click the New Step button, choose Grab screenshot, and set the region to the resource you created for
the preview area. Ignore the Remove horizontal line checkbox, because that is a very specialized feature.

10. Add steps for each script that is desired.

11. Click Ok to close the Edit Protocol window.

12. Click Ok to close the Edit Profile window

13. Click Ok to close the Setup Server window

2.3.5 Testing the Capture

1. In the Capture tab, click the Control Microscope button.
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2. Click the Capture Image button.

The image should be successfully captured. If you receive an error message, you may need to go back and edit the
steps in the Edit Profile window.

2.3.6 Setting up Auto-Focus

Here are the steps for setting Pix2Net up to automatically adjust the focus during a run:

1. In the Edit Profile screen, in Resource mode, draw a box around the button that turns on reduced area.

Give it a name such as “Turn on Reduced Area”, and add it as a Fixed Image resource.

1. Switch to Interactive mode and click on the reduced area button. Once the SEM is in reduced area mode,
switch back to Resource mode, draw a box around the button that turns reduced area mode off, give it a name
such as “Turn off Reduced Area”, and add it as a Fixed Image resource.

2. Click the Protocols tab, select the main protocol, and click the Edit Protocol button.

3. Select the Auto-Focus command and add the following steps:

2.3. Setting Up Pix2Net Server 15
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Step Fields Description
Press
keys

Key se-
quence:
F5+Shift

This step will turn the crosshair off.

Mouse
press

Left
button,
Tar-
get area:
SafeArea.

This step will go to the safe area (i.e. a place on the screen that can be safely clicked without
doing anything).

Mouse
press

Left
button,
Target
area:
Turn on
reduced
area.

This step will put the SEM into reduced area mode.

Mouse
press

Left
button,
Tar-
get area:
SafeArea.

This step will go to the safe area.

Wait
for
im-
age
to
match

Fixed
image:
Turn off
reduced
area,
Time
to wait:
5,000
ms.

This step will wait up to 5 seconds for the SEM to enter reduced area mode.

Mouse
press

Left
button,
Target
area:
Unpause
button.

This step will put the SEM into live mode.

Mouse
press

Left
button,
Tar-
get area:
SafeArea.

This step will go to the safe area.

Wait
for
im-
age
to
match

Fixed
image:
Pause
button,
Time
to wait:
5,000
ms.

This step will wait up to 5 seconds for the SEM to enter live mode.

Ad-
just
fo-
cus
in
re-
duced
area

Color
of rect-
angle:
Green,
Full
area:
Preview.

The Preview resource should be a bounding box around the place in the SEM’s GUI where
the SEM image is drawn. During this step, Pix2Net will identify the reduced area bounding box
by its color, which should match the color specified for Color of Rectangle. Pix2Net
will move the reduced area box to a suitable location on the screen, and then it will perform
the Increment Focus and Decrement Focus commands until the reduced image is a
sharp as possible. In order for this to work, it is important that the SEM’s crosshair is hidden,
the SEM is in reduced area mode, and the SEM is in live mode.

Mouse
press

Left
button,
Target
area:
Pause
button.

This step will pause the SEM.

Mouse
press

Left
button,
Tar-
get area:
SafeArea.

This step will go to the safe area.

Wait
for
im-
age
to
match

Fixed
image:
Unpause
button,
Time
to wait:
5,000 ms
.

This step will wait up to 5 seconds for the SEM to pause.

Mouse
press

Left
button,
Target
area:
Turn off
reduced
area.

This step will cause the SEM to leave reduced area mode.

Mouse
press

Left
button,
Tar-
get area:
SafeArea.

This step will go to the safe area.

Wait
for
im-
age
to
match

Fixed
image:
Turn on
reduced
area,
time to
wait:
5,000
ms.

This step will wait up to 5 seconds for the SEM to leave reduced area mode.

Press
keys

F5+Shift. This step will turn the crosshair back on.
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You can test this command by returning to the Capture tab, clicking Control Microscope, and then clicking
the Auto-Focus button.

2.4 Navigating a Project

This tutorial will introduce you to the basics: How to open projects, toggle layers, toggle cells, add bookmarks, add
rulers, and configure shortcut keys to commands.

2.4.1 Unzipping the Examples

Unzip examples.zip to a directory on your computer. On Windows, use an unzipping program such as 7-Zip.

2.4.2 Opening a Project

1. Go to the File tab and click Open Project.

2. Browse to examples\Digital Logic\Pix2Net.prj, and double-click the Pix2Net.prj icon or
click the Open button.

3. When the project finishes loading, the Overlay window will appear.

2.4. Navigating a Project 17

http://www.7-zip.org/


Pix2Net Documentation, Release 1.10.07

To pan around in the Overlay window, hold down the middle mouse button and drag the screen in the desired direction.
To zoom in and out, use the mouse wheel. To zoom in finely, hold shift and scroll forwards and backwards on the
mouse wheel. If there is no mouse wheel, use CTRL and the hold the right-click on the mouse to pan, and use + and -
to zoom in and out. NOTE If the mouse that is being used is touch (instead of click), use two fingers to represent the
right-click.

By default, the Zoom to Area tool should be selected. Select the Home tab to verify. If not, select Zoom to
Area.

To use this tool, hold down the left mouse button and draw a rectangle around the area you want to magnify. Press the
Home key to restore the original magnification.

2.4.3 Viewing Layers

The layers are controlled in the Layers window.
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Try turning different layers on and off, and changing their display settings.

2.4.4 Viewing Cells

The cells are controlled in the Project Cells window.

2.4. Navigating a Project 19
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Right click on AND2X2MHT to bring up the context menu:

1. Click Show AND2X2MHT to show all instances of that cell.

2. Click Hide All in the context menu to hide all of the cells.

3. Click Add Persistent Filter to show all instances of the cell persistently. (Until you click Hide All
again)
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4. Repeat with other cells. To turn on/off persistent cells, click the icon to open the Cell Visibility
pane. Toggle cell visibilty with the check boxes.

1. Close the Cell Visibility pane by clicking the red x in the upper right corner of the pane.

2.4.5 Adding Bookmarks

1. In the Overlay, move to a random location and zoom in.

2. Go to the View tab and click Bookmarks.

3. Click on the green plus sign to add a bookmark (a window will pop up asking for a name) and name it
Untitled.

4. Highlight Untitled, select the pencil, and rename the bookmark to My Location.

2.4. Navigating a Project 21
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5. Move to a different location in the Overlay.

6. Double-click My Location in the Bookmarks window. In the Overlay, the camera will snap back to the
original location.

7. Highlight My Location and click the red ‘x’ to remove the bookmark.

8. Close the Bookmarks window by clicking the red x in the upper right corner.

2.4.6 Adding Rulers

1. Go to the Home tab and click Micron Ruler.

2. Click and drag in the Overlay window to create a ruler. Hold down shift to force an orthogonal line.

3. Click Select Ruler.
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4. Click and drag in the Overlay window to draw a box around the ruler. The ruler should now be selected.

5. Right-click in the Overlay to bring up the context menu. Click Selected Ruler → Delete. Or, hit the
delete key.

2.4.7 Configuring Shortcuts

1. Click Configure Shortcuts.

2. In the Configure Shortcuts dialog, scroll down to the Full Zoom command.

3. Click on HOME, in the right-hand column. You will be asked to enter a new shortcut key. Press the J key.

2.4. Navigating a Project 23
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4. Press the Ok button to close the dialog.

5. Hover over the Full Zoom button to see the updated tool tip.

6. Press the J key. The Full Zoom command should be executed, causing the camera to zoom out to the original
position.

7. Open the Configure Shortcuts dialog again, and set the Full Zoom command back to the Home key.

2.5 Starting a New Project

1. On the “File” tab click the “New Project” icon to begin the new project.

2. Select the location of where the project will be saved. The template can be set at this time. Pix2Net comes pre-
loaded with a standard template for capturing a layer. If the default template does not match the user’s needs, it
can be changed. Please see Templates for more information.
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3. A new Pix2Net project is a directory consisting of 3 subdirectories and a Pix2Net.prj file.

archive Stores zip files for backup purposes

data The database files

images Images stored as an enumerated directory for each image layer

2.6 Capturing a Layer

This tutorial will show you how to capture a layer.

Note: Before proceeding a new project must be created :ref: starting-a-new-project

2.6.1 Connecting the Stage

Note: Stages X-axis and Y-axis will vary from system to system - user will need to determine correct
settings for their specific system.

1. Go to the Capture tab and click the Stage button.

2.6. Capturing a Layer 25



Pix2Net Documentation, Release 1.10.07

2. Set Type to MSI-2 w/Rotation.

Set Port to the com port that is connected to the stage. The stage must be powered up when Pix2Net is started,
or else you will not see the stage’s com port in this list. If you are unsure about the correct com port, you can
go to Control Panel -> Device Manager and look at the entries under Ports (COM & LPT). If you connect and
disconnect the stage’s USB cable, then one of the com ports should appear and disappear.

The Y-Axis should be inverted, so that the screen will pan down as the y coordinate increases, and the screen
will pan up as the y coordinate decreases.

The Home on Connect button should be checked if this is the first time you are connecting to the stage after
the stage has been turned on.

Click the Connect button to connect to the stage. It will do a homing process that takes a minute, and then the
stage will be ready.

3. Click the Manual Move button.

4. In the Manual Move panel, enter coordinates into the Stage X and Stage Y fields. Press the green button
to move the stage to those coordinates.
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The SEM image should move right if the x coordinate increases, and left if the x coordinate decreases. The
SEM image should move down if the y coordinate increases, and up if the y coordinate decreases.

2.6.2 Connecting the Camera

1. Start the Pix2Net Server on the SEM computer. For more information about the Pix2Net Server, see the tutorial
on Setting Up Pix2Net Server.

2. Click the Camera button.

3. Set the Type to Microscope and click the Connect button.

4. To capture a test image, click the capture button in the Manual Move panel.

2.6.3 Aligning the XY Stage to the Device

Before capturing the layer, you must use the Pix2Net rotation stage to rotate the device until the device is aligned with
the Pix2Net XY stage. You can not use the SEM’s rotation stage to accomplish this, because the SEM’s rotation stage
will rotate the Pix2Net stage and the device simultaneously. You can adjust the Pix2Net’s rotation stage manually in
the Manual Move panel, but it is usually easier to use the Rotation Alignment feature.

1. Click the Rotation Alignment button.

2.6. Capturing a Layer 27
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2. Follow the instructions in the Rotation Alignment window, and then click the Next Step button to
perform coarse alignment.

3. Continue to follow the instructions in the next two steps to perform fine alignment.

2.6.4 Setting up a Run

1. Click the Capture Config button.

2. Click the Show options button to bring up the options.

3. In general, these options rarely need to be changed, but it is good to be aware of these settings:

Overlap determines how much the images should overlap with their neighbors.

Stabilization Time determines how long Pix2Net should wait for the stage to stop moving before it
captures an image. If this amount of time is too short, the stage may still be moving slightly as the image is
captured.

If you turn on Backup Images, and specify Backup Location, then a copy will be made of each captured
image in the backup location.
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Click Cancel to close the options dialog, click Ok if changes were made to save.

4. Click the Add Area button. Enter a name for the new area. The Copy values from field allows you to
initialize an area with the values from an existing area, but since this is the first area you are creating, it must be
set to [None]. Click Create.

5. The Capture Configuration property list should appear.

2.6. Capturing a Layer 29
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6. Fill out the layer properties.
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The X, Y, Width, and Length properties define the location and size of this area.

Pixel Width will be used to determine the number of images that must be shot to capture this area.

The rest of the properties are optional.

7. Fill out the focus settings.

• Do not adjust focus - If you select this option, then Pix2Net will not adjust the focus during the
run.

• Dynamically adjust focus - If you select this option, then the focus will be automatically ad-
justed every time that Pix2Net moves the stage the specified distance along each row. For example, sup-
pose that the specified distance is 5 um and every row is 12 um long. In that case, the stage will be adjusted
3 times during each row: Once at 0 um, again at 5 um, and one last time at 10 um.

• Create a focus adjustment schedule - If you select this option, then you can create a focus
adjustment schedule by specifying the desired focus amount at different locations on the device. The nice
thing about specifying a focus adjustment schedule is that a scheduled focus adjustment is faster and more
reliable than attempting to dynamically adjust the focus. You can manually add points to the table, but an
easier way to fill out the table is to use the focus adjustment controls in the Manual Move panel. Go
ahead and click Save to save this area, and then look for the focus controls on the Manual Move panel:

Move the stage to the upper left corner of the device, make sure that the focus looks good, and then click
the Add Focus point to add this point to the table.

Move to the upper right corner of the device, adjust using the focus field.

2.6. Capturing a Layer 31
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Click the Go to specified focus value button to adjust the focus, and then add another focus
point.

Repeat this procedure for the lower left and lower right corners of the device. Open the Capture
Config window again. You should now have four sampled points in the sampled focus point table.

Finally, if you are worried that the ideal focus will change over time, you can select In addition,
dynamically adjust focus at the beginning of each row. In that case, when
Pix2Net moves the stage to the beginning of a row, it will apply the scheduled focus adjustment first,
and then it will dynamically adjust the focus.

8. You can get an estimated capture time by setting the correct Tile width, Tile height, and Time per
tile.
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9. Click the Save button to save the area you just created.

2.6.5 Starting a Run

Ensure the layer you want captured is selected before starting the run.

Click the Start button to start the capture.

Pix2Net will start (or resume) the first enabled area in the list of areas to capture. Once Pix2Net finishes that area, it
will disable it, and move to the next enabled area. If there are no more enabled areas, Pix2Net will stop capturing.

2.6.6 Viewing Capture History

After you have captured some layers, you can view and export the information for those layers at any time.

1. In the Layers window, click the Show Capture History button.
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2. The Capture History window will show information about each layer that has been captured with the
fields populated by the template used.

3. You can use the Select columns button to edit the columns that are shown. By default, the settings will be
the column settings that you specified when you created the template.

4. You can use the Export button to export the columns to a csv file, which can be opened as a spreadsheet by
Microsoft Excel.

2.7 Importing and Stitching Images

This tutorial will show you how to import images and stitch them.

2.7.1 Open the Example Project

1. Go to the File tab and click Open Project.

2. Open the project file Digital Logic

2.7.2 Importing Images

1. Click Import and select Multiple images....

2. Browse to Digital Logic\images\28 and click the Open button.
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3. In the General tab, set Rows to 6, Columns to 7, and Resolution to 102.987.

If the image capture was completed by Pix2Net then these values are auto-completed, otherwise the user will
need to manually input the values.
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4. Click the Import button. For the example project, the import process should take less than 15 seconds. On
regular projects it depends on the size of the layer.

5. Go to the View tab, the Overlay option should be highlighted. If not, select Overlay.

6. In the Layers window, ensure the layer to be stitched (the example layer) is enabled. If not, click checkbox to
enable.
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We have successfully imported an image layer into the project. However, the layer doesn’t look right, because the tile
boundaries are not flush (when zoomed in). To fix that, we need to stitch the images.

2.7.3 Stitching Images

In the alignment tab, open the Stitch Manager and press the Stitch button.
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All green lines means that it was stitched perfectly. You can now zoom in and out and see the difference.

2.7.4 See More

For more information on stitching, see the Stitching reference.

2.8 Aligning Layers

This tutorial will show you how to use the tools in the alignment panel to align two image layers.

2.8.1 Moving Layers

1. Open the Digital Logic project.

2. In the Layers window, set the m1 and CA image layers to visible. Set a orange color for the CA image layer.

3. In the Layers window, right-click on m1 to bring up the context menu. Choose Reset Warp.
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4. Go to the Alignment tab and click Move.

5. Click and drag to move the m1 layer around. If you want to undo a move, use Ctrl+Z.

2.8.2 Using Anchors

The Move, Scale, and Warp tools work for smaller image layers, but they are difficult to use with large image layers.
On the other hand, the anchor system allows users to align two large image layers very quickly.

NOTE The user must have View Anchor and Add Anchor turned on to place and add anchors. It is recommended to
use the Alignment Review as well to help shorten the alignment process and to look at each anchor’s bend percentage.
See Alignment Review

1. Select View Anchors.

2. Click the add button in the Anchors window.

3. Leave anchor mode as Interlayer Alignment and set m1 as the Moving Layer, and CA as the
Stationary Layer. Click the Create button.
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4. Select the m1 - CA group in the Anchors window. Click Add Anchor.

5. In the upper left corner, click and drag to move the m1 layer until it is lined up with the CA layer. An anchor
point will be added when the mouse button is released.

6. Continue to add anchors until the m1 layer is aligned to the CA layer. NOTE Always lay out the corner an-
chors before moving on to the middle anchors, if the first anchor is at the top left, place the next anchor
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in the bottom right (so, always place the second anchor in the opposite corner). For this small layer, 20
points are enough.

7. To check the bend percentage between the anchors, click on Alignment Review in the Alignment tab, and
then Calculate Bend Percentages. See Alignment Review

8. After the moving layer is aligned to the stationary layer, it is recommended that the user right-clicks on the
recently aligned layers and click on Lock --> Alignment to ensure that the layers will not move.
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2.8.3 Layer Orthogonal Tool

Using this tool allows the user to straighten the image. To do this, click the + sign in the Anchor Groups and then
select the layer that is to be straightened. The easiest way to straighten the image is to try and find a line or straight
segment that runs through the whole image. Left clicking and dragging the orthogonal anchor through the straight line
will force the image to become straightened to that line. When using the orthogonal tool, most images only require
two lines, one horizontal and one vertical.
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2.8.4 Cell Alignment

The “cell” alignment type for anchor groups is used to align a collection of cells to an image layer. The primary use
case for this form of alignment is in conjunction with the “fill with memory grid” tool, which creates a grid of child
cells within a parent cell. The created cells may not be perfectly aligned with the structures they are meant to bound,
but there could be too many to adjust by hand. By using a cell alignment anchor group, these cells can be aligned in
the same way that two layers can be aligned. When creating the group, the user must select a stationary image layer
and a parent cell. The parent cell is the cell containing the child cells which are misaligned with the stationary image
layer. Once the anchor group has been created, the standard anchor tools can be used to place anchors to align the cells
to the image. There is one caveat, though. Because aligning cells can be a long-running operation, the system will not
automatically execute an alignment operation after a cell anchor has been placed. Instead, the cells will snap back to
their former position to allow the user to continue to add anchors. The apparent cell alignment will not improve unless
the user clicks the “align anchors” button to perform the alignment.

2.8.5 More Information

For more information please click this link View Anchors

2.9 Polygon Extraction

The following tools are available for Polygon extraction:

• Filtering and Edge Detection

• Neural Network

• More Details About Extracting

2.9.1 Filtering and Edge Detection

1. Before starting, make sure that the example Pix2Net project Digital Logic is opened

2. Turn on the example layer that was created in the importing and stitching section of the tutorial

3. Go into the image tab and press Extract Polygons

4. A feature extraction window will open
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5. Make sure to check Show polygons and that under extract lines is selected (select vias when extracting
vias). The polygons will appear in the bottom left and right hand corners of the window.

6. If large lines or squares do not convert to polygons, it’s due to small voids in the material. If you use a dilate
filter it fixes the problem. see Filters

7. Look around at the polygons to make sure that there is no bridging or open spaces. Do this by looking at different
tiles to check how the polygons will look when extracted

8. The extraction will not always be 100% accurate, so the user may have to put a filter
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9. There are many different filters that each have a unique way in helping extract the polygons to make the image
look better.

10. Once the polygons in the feature extraction look like they are ready, press the extract button.
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2.9.2 Neural Network

Before starting create a restore point for the project. Add Restore Point

Neural networking allows the Pix2Net program

1. Select image layer for extraction - for this training exercise, choose M1.

2. Under the “Image” tab, select “Clear Polygons”. NOTE: Before confirming deletion of polygons, create a
restore point.

3. After polygons are cleared, select “Extract Polygons”. Neural Network drop down under “Line Settings” should
be blank. Select “Show Polygons” should be checked.
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4. Select “Add Image to Training Set”. Enter “Training” to name. “Type” should be on filter (filter=lines,
vias=vias).
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5. Clean up image (training exercise doesn’t allow this, but these examples show what would need to be cleaned
up).

6. There is a “erase” and “add” tool to help with the cleanup.
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7. Once the image is cleaned - select close.

8. Choose another image by entering a new tile number into the “Preview Settings”. Select “Add Image to Training
Set”, but this time select “Add to existing training set” and select set that was created.

9. Clean up image and continue the process until there is a minimum of 3 images in the training set.

10. Select “Cancel” - do not click “Extract”.

11. Select the “Neural Network” icon.

NOTE: At this point the user will need a computer with CUDA (Compute Unified Device Architec-
ture).

12. Click “+” to add neural network

13. Name the neural network. Adjust the settings for the demo to the following: Resize image to 50% and Step Size
to 500.
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14. In the Training Sets window click “+”. Select the training set that was cleaned up in the extract window.

15. “Create”. On the next pop-window, select the neural network that was just created and click the “Train Neural
Network”.
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Neural Network should run until the results hover around 1% or lower, or until the results stop getting
better.
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16. Click “Stop”. Close window. Choose the “Extract Polygons” icon in the tool bar.

17. Under “Line Settings” select the Neural Network created for the training.

18. Click “Extract”.

2.9.3 More Details About Extracting

For more information on extracting polygons, extracting only vias, filters, and more, please see Extract Polygons.
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2.10 Synchronization

2.10.1 Synchronize Mode

Synchronization mode must be turned on if you are doing collaboration and you are not the master project.

When highlighted any commands that are not recognized by the synchronization system will be grayed out.

2.10.2 Synchronize

Synchronize is intended to divide up the work on the project. Start with a project that has layers stitched, aligned and
polygons extracted. Archive the project (Recovery System) then make as many copies as desired of this master project.

The designated master project may perform any operations. All of the copy projects should click on the Synchronize
Mode icon to prevent performing operations that do not synchronize. The icon will be highlighted as shown:

To exit synchronize mode, click the Synchronize Mode icon again. The following confirmation will appear:

When ready to synchronize a copy project, click the Synchronize icon. You must have the “Master” project opened.

This will bring up the Sychronize Projects window. Click on the Add button to Add New Job.
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Click Add again to Add Project.

Name is the identifier for the instance of the project. This is for user reference and is arbitrary.

Directory should be the file system or network path to the Pix2Net project file.
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Synchronization job will be created.

Click Run.

Sync process will vary from project to project, depending on file size.

Pix2Net will confirm successful synchronization.
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2.11 Identify Cells by Truth Table

This tutorial will show you how to automatically identify a cell. You will learn how to create a cell and how to use the
cell identifier.

2.11.1 Creating the Cell

1. In the Layers window, turn on the m1 image layer.

2. In the Project Cells window, click the down arrow on dig block, block 0 array, and then buf. Then, click
the down arrow in the window that moves the user into the target netlist.
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3. Remove the old cell. In the Project Cells window, right-click on BUF (430), and choose Delete BUF.

4. Go to the Cells tab and click Add Cell.

5. Click-and-drag to add a new cell and a window like this will appear:

6. Make sure that Automatic ports are turned off and then press add four times

7. Next, name the ports A, B, C, and D, and their types as VDD, VSS, input, and output, respectfully.

8. Click create cell.

9. Make sure that once the cell is created, in project manager the cell visibility button has show port names
checked.

10. Now, move A, B, C, and D into the following spots:
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2.11.2 Creating the Netlist

1. Open the Netlist tab click Create Netlist.

2. In the Create Netlist window click M2, M1, Polysilicon, N-Diff Active, and P-Diff
Active to include all layers in this cell.
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3. Click Create to have the software generate the netlist for this cell.

2.11.3 Identifying a Cell

1. In the Netlist tab, click the Find Transistors button then Find. This process will identify and place
all of the transistors.

2. Now make sure that everything looks good. Press Show Schematic and a window like this should appear:
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1. After the transistors have been placed the software can browse the reference library to see if an instance of this
cell has already been cataloged. To do this click Identify by Truth Table.

2. If the cell found a match a window will pop out giving you the option to keep the cell name, ports and the
schematic image identical to the instance in the reference library. Click on the first BUF and then press the
green checkmark to confirm, then press copy.
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3. The user will see that the Pix2Net changed the cell to what it should be officially identified as

1. Go to the File tab and click Recovery System. Restore the backup of the project to undo your changes.

2.12 Adding a Cell and Searching for its Instances

This tutorial will show you how to add a cell and search for its instances.

This tutorial includes the following:

• Adding the First Cell

The rest is over the Digital Logic project

• Adding a Cell

• Identifying the Cell

• Performing a Cell Search

• Adding Key Points Manually

• Viewing Cell Instances

• Editing Cell Instances
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2.12.1 Adding the First Cell

Recommended the user should have cell identification knowledge before placing cells.

2.12.2 Adding a Cell

1. Open the Digital Logic project.

2. Add a restore point so that all changes made in this tutorial can be reverted. To do this click the Add Restore
Point icon in the File tab. Notes can be added to the restore point to keep documentation of the progress.

3. In the Layers window, turn on the m1 image layer.

4. In the Project Cells window, click the down arrow on Dig Block, Logic Block 1, and then click and
highlight 2NOR (85). Then, click the green down arrow in the window; this moves the user into the target
netlist.

5. Remove the old cell. In the Project Cells window, select 2NOR (85) then right click and select Delete
2NOR, yes.
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6. Next, go to the Cells tab and select Add Cell. Draw a box over the 2NOR that was just deleted.

7. A window will pop up, generic should be automatically highlighted. Click Create Cell.

8. While the new cell is selected, press on Create Netlist. Library Cell should be selected in the drop down.
Active, Polysilicon, and M1 should be enabled and set to correct conductors through the correct vias. Click on
Create if everything looks correct. If not, the user is able to click on the drop down bar and select Custom to
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make any changes necessary. It should look like this:

2.12.3 Identifying the Cell

1. Now, click on Find External Ports, make sure “Cell type” - “Library Cell” bullet is checked, then select
Find Ports, and Pix2Net will add the necessary amount of ports onto the cell. (The user can make sure that
all the ports are correct by pressing on Show Schematic to see how each port is connected.)

2. Next, click on Identify Cell and press Confirm. Pix2Net will figure out what type of cell it is. In this
case, there is a NOR2NOR2, or a 2NOR.
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2.12.4 Performing a Cell Search

Now that there has been an identified cell within Logic Block 1, the user is able to find all the other cells exactly like
the cell that was just created.

1. Click Cell Search.

2. Select the whole Logic Block 1 cell by having select highlighted, and then clicking once inside the cell (where
there are no other cells).

3. In the Cell Search window, press on the Cell Link icon to tell Pix2Net to search in the area selected. In this case,
it is Logic Block 1
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4. Go to the 2NOR and select it and then press the green plus button to add it to the cell search and click on 2NOR
to highlight it.

5. Open Cell Search Settings.
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6. Click + to add new layer search.

7. Select image layer (the layer(s) that uniquely identify the cells) for cell search. Click “Add”.
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8. Click “Initial Key Points” and select polygon layer to use as reference for key points. Click “Save”

NOTE To see key points, make sure that the cell is highlighted in the Cell Search window, key points are
defined in the settings of the Cell Search, and the image layer is turned on. The user can double-click on
the cell in the cell search to have Pix2Net move the overlay to where the cell is.

9. Click the play button (start search) The results should look like this:
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10. Check the results and make sure that the identified cell(s) look as they should. If everything is correct, click on
the green octagon to confirm the results. Pix2Net will automatically place the ports and identify it as the same
type of cell.

2.12.5 Adding Key Points Manually

Before adding key points

When doing a cell search, the user can add Key Points to tell Pix2Net to look for selected specific points when
searching for cells. In order to see key points, the user needs to have the “Cell Search” window open, and have one of
the cells selected in the list. (Double-clicking on that cell will take the user to the correct place in the overlay.) Finally,
the image layer that was added the key points to must be visible. If the key points are not showing up, then the most
likely causes are that the cell is not selected in the “Cell Search” window, or the image layer the key points were added
to is not visible

If the key points that were added automatically within the cell search settings under Initial Key Points are not
to the user’s satisfaction, then the user can manually add the key points themselves.

NOTE We do not recommend manually adding key points unless the automatically added key points were not placed
correctly, did not help the cell search, or if there is no layer to reference key points to.

In this part of the tutorial, all of the steps above can be applied, but instead, start after step 6, do not do step 7.

7. Press the green down arrow on the 2NOR in the Project Cells window (if this has not already been done).

(In this example the Polysilicon image and polygon layers are on, as well as the Contact polygon layer to show the
user where we would recommend placing the key points)
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8. Go to the Cells tab and click on Add Key Points.

9. Add the key points within the cell to tell Pix2Net to specifically look for similar points while searching for the
same cell.

10. Make sure that 2NOR is highlighted in the cell search window, then press on the play button (start search) and
Pix2Net will find all other cells that are the same.

(This will be the exact same way of searching as above, but the user manually places the key points instead of having
Pix2Net do it.)

2.12.6 Viewing Cell Instances

1. To review the results, go to the Project Cells window and click the Cell Instances button.

2. Click on an instance in the Cell Instances window to visit it.
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2.12.7 Editing Cell Instances

1. If you find an instance that has been incorrectly added by the Cell Search algorithm, you can delete it manually.

Make sure the instance is selected. Then right-click it and select Delete Cell Instance.

2.13 Extracting Memory from Images

This tutorial will show you how to extract the bit values from an image layer of memory blocks. You will learn how
to setup the memory extraction, perform the memory extraction, manually edit uncertain bits, and export the results to
an Excel file.

2.13.1 Adding Template Cells

1. Open examples\Memory Extraction\Pix2Net.prj.

2. Go to the Cell tab and click Add Cell.

3. In the Overlay window, click-and-drag in the upper left corner to create a cell around the block in the upper left
corner.
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4. An Assign Electrical Model and Ports window will pop up.

5. Click on the Cell Name and name the cell Memory Block.

6. Click on ROM under Name and click Create Cell

7. Right-click in the Overlay window to bring up a context menu. Choose Selected Cell → Identify as Origin
Block. This tells Pix2Net that this cell will act as the upper-left corner of the region of interest.

8. Bring up the context menu again and choose Selected Cell → Identify as Contrast Block. This tells Pix2Net that
this cell is a good template for the other blocks; it is neither extremely dark nor extremely bright. For this demo,
we are able to use our origin block as our contrast block, but that will not always be the case.

9. In the Overlay window, add a new cell around the first bit.
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10. In the Project Cells window, rename the new cell to Memory Bit.

11. Select the Add Cell Instance tool.

12. Add more Memory Bit instances by clicking on each bit. If you make a mistake, use the Move tool to move
the instance into the correct place.

13. Select the Select tool.

14. Click on a dark instance to select it. Right-click to bring up the context menu. Choose Selected Cell → Identify
as 1-bit. Repeat the same process for a light instance, except choose Selected Cell → Identify as 0-bit. Pix2Net
will use these templates to decide if a bit is a 0 or a 1.
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2.13.2 Extracting Memory

1. Go to the Image tab and click Extract Memory.

2. We need to fill out the dialog:

• The first table in the dialog shows the cells we’ll be searching the images for (only cells of type ROM will
be listed). The default Min Correlation of 80 is fine for this example.

• Layer specifies the image layer to use. There is only one layer in the project, so this is an easy choice.

• Block Labels specifies the label category to add our results to. Since this is the first time we’re doing
an extraction, we have no choice but to create a new category.

• Block Search Area is the width and height, in microns, of the search area. When the cell search
starts, you will see a little red box that shows you where Pix2Net is looking for the next block. We are
setting the width and height of that box here. We will use 80 and 15 microns.

• Grid Size is the width and height of the region of interest, in terms of blocks. Our grid is 5 blocks wide
and 17 blocks tall.

• Block Focus Size is for bit identification. When Pix2Net is trying to determine if a bit is dark or
light, it is using the intensity of the contrast block as a base line. However, the contrast block may have
bad pixels around its edges. We’ll stick with the defaults, which means we’re telling Pix2Net to use the
middle 80% of the contrast block when calculating the base line.

• Bit Focus Size is for bit identification.

• Bit Focus Weight is for bit identification.

• To understand what Refine Block Locations does, you must understand the memory extraction
process. First, Pix2Net will find all of the blocks along the edges of the region of interest. Then it will
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estimate where all of the inner blocks are by using interpolation. Refine Block Locations tells
Pix2Net to improve on this interpolation by individually examining each block and adjusting its placement.

• Identify Bits tells Pix2Net to perform bit identification after the blocks have been found.

3. Press the Extract button to start extraction. After the process completes, you should see the detected bits:
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2.13.3 Editing Bits

1. Go to the View tab and click Reports.

2. A report of uncertain bits has been generated. Click on the report to see the list of potential problems.

3. Click on a problem to go straight to the uncertain bit. If the bit is wrong, go to the Labels tab and click on
Select Label.

4. Click on the bit label to select it. Click Edit Label, change the value to the correct value, and then click the
Save button.
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2.13.4 Exporting Bits

Note: This feature has been temporarily disabled.

1. Go to the Image tab and click Export Bits.

2. Set the filename to the desired location. Row Drift determines, going from left to right, how far two consecutive
bits can differ vertically and still be in the same row. Let’s use a value of 500. Finally, leave the default values
for Flip and Rotate, because we don’t want to flip or rotate the values.

3. Click the Export button. A csv file will be generated, which can be opened in Excel.

2.14 Comparing a Layer to a Golden Layer

2.14.1 Importing the Golden Layer

1. Open the examples\Golden Demo\Pix2Net.prj project. You should see the fabricated layer.
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2. Go to the Trusted Design tab and click Import Golden.

3. Browse to examples\Golden Demo\golden.gds and click the Open button. The golden GDSII file will
be imported into Pix2Net.

4. In the Layers window, right-click 19_0 and choose Rename. Rename the layer to Golden.

5. Turn on polygon layer.
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2.14.2 Running a Golden Compare

1. Click Golden Compare.

2. Click “+” to add new comparison.

3. Set the Golden layer to Golden and the Fab layer to Fabricated. Click “Add”.
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Note: If there is an area which you do not want compared in the process, you’ll need to create an “ignore” layer. See:
Create Layer.

Once the layer is created, add polygons to the area you want “ignored”.

1. Select the “Ignore Layer”.
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2. Set the “Tolerance”. This will determine how much difference between the golden and fabricated layer is needed
before an error is flagged.

3. Click the “Run” button.

4. The compare process will take several minutes. A Differences layer will be generated.

2.14.3 Viewing Differences

1. Click Reports.

2. The Reports/Entries window will appear. Click on the report to see the list of differences. Click the first column,
so that it is highlighted in blue, to see the red dots (errors) first.

3. Click on a difference in order to go directly to it. See Types of Differences for more information about what the
differences mean.
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2.14.4 Exporting Differences

1. In the Polygon Reports window, click the Export button.

2. Select folder where report is to be saved.

3. Type in report and click the Save button.

4. Browse to the output folder and open report.csv with your preferred program.
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2.15 Legacy Project

This tutorial will only be used when upgrading Pix2Net projects from v0.19 to v0.20.

Make a spare copy of the project in case the upgrade process is unsuccessful. The upgrade process is
irreversible and will alter files in the project directory.

2.15.1 Opening the old project file

1. Go to the File tab and click Upgrade Legacy Project.

2. Browse to project\project.h2.db
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Note: Pix2Net will become unresponsive while upgrade process executes.

3. To continue opening the project refer to Opening a Project.

2.16 Identify Cells by Layout

This tutorial will show you how to use the layout matcher to identify project cells by their layout. Only use if you have
a gdsii library to compare against.

2.16.1 Import GDSII Files into the Reference Library

The first step is to import a library of GDSII files into the reference library.

1. In the Netlist tab, click the Golden Lib GDS button:

2. In the Golden Lib GDS window, click the Import Layout Reference Cells button:

3. In the Import Reference Layout Cells dialog, specify a library name for the layouts to import. Set
the layer number and data type that corresponds to the m1 layout, and the layer number and data type that
corresponds to the text layer with the port names. Finally, set the directory the GDSII files are stored in, and
click the Import button.
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4. In the Golden Lib GDS Results window, click the Manage Layout Reference Cells button:

5. The imported layout reference cells can be viewed in the manager window:

Click the Close button after verifying that the layout cells were imported correctly.

2.16.2 Settings

1. Open a project.

2. In the Golden Lib GDS Results window, click the Golden Lib GDS Settings button to bring up
the settings window:
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3. Set the Reference Layout Library that should be used by the Golden Lib GDS.

4. During the matching process, any match with a correlation score below the Minimum Correlation will automat-
ically be discarded.

5. During the matching process, any reference cell that has a width or height that differs by more than the Maximum
Cell Boundary Difference from the target cell’s width or height will automatically be discarded. This constraint
makes the matching process go much faster, because fewer correlations need to be performed.

6. Click the Ok button to save the settings.

2.16.3 Technology

1. In the Cells tab, click the Technology button.

2. Make sure that the Metal 1 layer has been specified in the project.

3. Click the Ok button.

2.16.4 Compare Cell

1. Select a target cell instance in the project.

2. In the Golden Lib GDS Results window, click the Identify the selected cell button:

3. The possible matches will be displayed:
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2.16.5 Confirm Result

1. Click the Confirm the selected match button to confirm the selected match as valid.

2. The Confirm Match dialog displays the identified cell name and port mapping:
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3. Click the Confirm button to rename the cell and ports.

2.17 Polygon Placement

This tutorial is aimed to help the user make polygon placement a faster process and to show how some Pix2Net
Polygon functions work.

1. Go to Examples/Digital Logic/ Pix2Net.prj for this tutorial.

2. Before starting, make sure that the M1 layer and polygons are on, as well as the Via 1 polygons.
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3. Go into settings under the Polygon tab and make sure that the visible layers settings is highlighted.

2.17.1 Polygon Placement Tutorial

Selecting, moving, and cloning polygons:
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1. Go to the top left of the Digital Logic in the overlay.

2. Use the Select Polygons tool to select the third half-column polygons on M1 and on Via 1. Once selected,
press delete on the keyboard.

3. Now, select the section of polygons two to the left of the column that was just deleted. (This is because the
polygons directly to the left do not match exactly to the polygons just deleted.)

4. Click on the Move Polygons tool to move over the selected polygons to the right.
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The overlay should look like this:

5. The polygons that were just moved should still be selected (if not, re-select them). Press on the Clone
Polygons tool and clone the polygons back to the place that they were originally by clicking once inside
the overlay and moving the mouse to correctly place the polygons.

2.17.2 Cloning Arrays

Cloning multiple polygons in different directions:

In this tutorial, start out the same way as above, but this will continue right after step 3, and will not include vias (turn
the via polygon layer off).

4. Go to the Home Tab and select the Micron Ruler.

5. Draw a line from the beginning of the first half-column to the exact same point at the beginning of the third
half-column. (Hold shift to make the ruler straight) It should look something like this:
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6. Now, click on the Clone Array tool in the Polygons Tab.

7. A window will pop up, use these numbers provided:

(The direction is right because the polygons are being cloned from left to right, the clone count is 1 because there is
only 1 clone of the selected polygons needed, and the step distance is 14.5 um, which is what the micron ruler shows.)

8. Click on Clone.

Note

This feature is very specific on how many units the user wants to move, if the polygons that were cloned are slightly
off, either use the Select Polygons and Move Polygons tools, or try again (Ctrl + Z first) by putting a more
specific value that will help the polygons match up.

2.17.3 Right-Clicking

The Use of Right-Clicking in Polygon Placement:
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The tools in the Polygons Tab are useful to the user for placing and copying polygons to get further in laying out
the GDSII, but right-clicking could be just as helpful in some situations.

In this tutorial, there will be quick transitions to different locations in the overlay by using tiles, we recommend to use:
‘go to - coordinates’ in bigger projects.

1. Turn on the Polysilicon layer and polygons.

2. (Make sure to be fairly zoomed into the Overlay) Right-click in the Overlay, hover over Go-to, Tile and click.
An Input Window will pop up, type in 8 and press ok. This is what it should look like:
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3. Now, use the Select Polygons tool to delete the polygons in the middle (either press the delete key or right
click and go to selected polygon, remove).
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4. Select the polygons that look similar, to the left, of those that were just deleted.

5. Clone those polygons over to the space where the polygons were deleted.

6. Select the polygons that were just cloned over and then right-click. Go to Selected polygon, Flip left to right.

7. It should look the same as the polygons that were deleted earlier. Use the Move Polygons tool to move the
polygons to the correct place.

8. Now, at the same location, use the Select Polygons tool to select the polygon in the middle-right section
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of the Overlay.

9. Clone that polygon to the black space to the left.

10. Select the cloned polygon and right-click. Go to Selected polygon, Move to layer.

11. A Move to Layer window will pop up, select Active and then ok.

12. Turn on the Active layer and polygons and select the polygon that was just moved to that layer.
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13. Move the polygon back to the place that it was originally, and then that polygon will be on both the active and
polysilicon layers.

2.17.4 Selecting and Cloning Areas

Select the Select Area tool and select an area around some polygons.
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Here is an area where polygons were not correctly extracted. Looking at the picture, the two lines should be completely
filled and the middle should not have polygons.
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Going back to the picture of the selected area, there is a perfect fit to what is needed.
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Once placed, the incorrect polygon extraction will then turn into the exact same as whatever was inside the selected
area.
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2.17.5 Settings

The polygon settings windows allows adjustment to the line thickness and square size in microns. There is also a
setting to adjust the maximum polygon size

The max polygon size determines the maximum width and height of the polygons in the project. If a tool attempts to
create a polygon larger than this size, the polygon will automatically be split until its dimensions no longer exceed the
max polygon size. If this value is too high then polygon rendering and netlisting will start to become inefficient.

Select active layer to tell Pix2Net that when selecting layers, the user only wants to select the active layer. Select
visible layers to be able to select all visible layers with polygons.
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2.17.6 More Information

For more info on other functions in the polygon tab, see Polygon Tab

2.18 Templates

This tutorial will show you how to use a project template to attach extra information to your project and your captured
layers. For example, you can use a project template to associate a part number with every project.

2.18.1 Creating a Project Template

1. Go to the Home tab and click Manage Templates.

2. Click the Add Template button to add a new template. Enter a name for the template and press Ok.
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2.18.2 Adding Properties

You should now be looking at the Edit Template window:
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You can use the Edit Template window to add properties to a template. A property is a variable (e.g. “Part
Number”) that an operator can fill out.

There are two property lists that you can add properties to:

• New Project - The operator will enter these properties when creating a new project. The properties in this
list should be the same for every layer.

• Capture Config - The operator will enter these properties when they are setting up a new run in the capture
config window. The properties in this list should vary from layer to layer.

You can add a property by clicking the Add property button. There are two types of properties you can create:

• Text - A text property is the default type of property. The user can set this property to any value they want to.

• Multiple Choice - A multiple choice property is a special property that has a fixed set of possible values.
For example, if the property is “Location”, then you could force the user to choose one of the following values:
“Lab A”, “Lab B”, or “Lab C”. Each possible value should be entered on a new line in the Choices text box.

You can use the arrow buttons to change the order the properties are listed in. When the properties are shown to the
operator, they will be in the order that you specify here.
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2.18.3 Managing Columns

Click the Columns tab to see the list of spreadsheet columns defined by this template. When an operator exports the
information for all of the layers to a spreadsheet, this list will determine which columns will be exported, and what
order they will be in.

You can include or exclude a column from the spreadsheet by toggling its checkbox, and you can use the arrow keys
to change the order of the columns.

Any properties that you have added to this template will also be available as columns in this list.
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This allows the user to save capture logs to a condensed file.

When you are finished, click Ok to save this template.

2.18.4 Managing Templates

The template you just created should now be displayed in the Manage Templates window. This template will now
be available as an option whenever you create a new project using this user account.

If this is the only computer you use to create new Pix2Net projects from, then you don’t have to do anything else. How-
ever, if you need to create new Pix2Net projects from another computer, then you can use the Export template
and Import template buttons to copy this template to other computers.
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Click Ok to return to the main window.

2.18.5 Creating a New Project

1. Go to the File tab and click the New Project button. Select the template you created and fill in the proper-
ties you added. Click Create to create the project.

Note: A copy of the template was passed into the project you just created, and that copy can no longer
be changed. You can still makes changes to the original template in the Manage Templates
window, but those changes will only apply to future projects.

2. After the project is created, go to the Home tab and click Project Properties.

3. If you ever need to review or modify the project properties, you can do it in this window:
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4. Click Cancel to close the Project Properties window.

2.18. Templates 111



Pix2Net Documentation, Release 1.10.07

112 Chapter 2. Guided Tour



CHAPTER

THREE

REFERENCE

3.1 User Interface

The title bar shows the name of the program, its current version, and the file name of the currently loaded project.

The overlay shows image layers, polygon layers and netlist properties. See Overlay Windows.

The layers pane allows control of the layers and their properties. See Layers Window.

The Project Cells Pane allows for the browsing, viewing, and setting of properties of cell. See Project Cells Window.

3.1.1 Ribbon

The ribbon is the large tool bar at the top of the screen. The ribbon is divided into tabs.

File Tab

The file tab accesses all interactions with project related files, including the Pix2Net project file, image files, gds, etc.
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The following tools are available in the File tab:

• New Project

• Open Project

• Open Recent

• Close Project

• Upgrade Legacy Project

• Import

• Export

• Add Restore Point

• Recovery System

• Rebuild Database

• Undo

• Redo

• Synchronize

New Project

The New Project icon creates a new Pix2Net project. For a tutorial see: Starting a New Project

Open Project

The Open Project icon pops up a browser to navigate to, and open an existing Pix2Net project file.

For a tutorial see: Navigating a Project
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The Pix2Net project files are stored as Pix2Net.prj

Open Recent

The Open Recent icon opens a menu of the five most recent projects opened in Pix2Net.

Close Project

The Close Project icon will close the current project. All changes are automatically saved.
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Upgrade Legacy Project

The Upgrade Legacy Project icon is for upgrading h2 database projects to the current postgres database. Pix2Net files
in the older h2 format will have the extension .h2.db. This will upgrade to the current, more efficient database.

The current database was updated in May of 2014. Any version prior to v0.20 will require an upgrade to the new
database.

When the icon is clicked the following confirmation dialogue will pop up:

Be sure to save a complete copy of the project directory before upgrading!

Import

This is used to import images, GDSII polygon layers, projects, XML files, FEI MAPS, indexed files, and neural
networks. For more information over different ways to import, please see Importing

Export

This allows the user to export various types of files, cells, and images. For more information on exporting GDSII,
cells, images, etc., please seee Exporting
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Add Restore Point

Adds a point in the current archive to restore to back to a certain date and time.

Recovery System

The recovery system manages archives and restoration points.
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Archives- lists the existing archive files. to make a new archive click the green plus sign.

Restore Points- lists the restore points in the selected archive.

To restore to a point, select the icon .

To restore to a time, select the icon . The following dialogue will appear:
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To rebuild the database, select the icon .

The following columns will be displayed for each archive:

Date The date the archive was created on.
Base Files The size of the base files.
Delta Files The size of the delta files.
Total The total file size of the archive with the delta files.

You are given the option to add a new archive or delete old archives.

The following columns are displayed for each restore point:

Date The date the restore point was created on.
Pix2Net The version of Pix2Net that was used to create the restore point.
Notes The notes that were attached to the restore point.

You are give the option to open a restore point, restore the project from a specific time, or delete a restore point.

Rebuild Database

In the event the project encounters an issue this feature allows the database to be rebuilt. This should be done only if
necessary and the project is corrupted.

Undo

Undoes the last command. To view command history click on the view tab and select Command History.
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Redo

Redoes the last command. To view command history click on the view tab and select Command History. View Tab

Synchronize

Synchronize is intended to divide up the work on the project. Start with a project that has layers stitched, aligned and
polygons extracted. Archive the project (Recovery System) then make as many copies as desired of this master project.

The designated master project may perform any operations. All of the copy projects should click on the Synchronize
Mode icon to prevent performing operations that do not synchronize. The icon will be highlighted as shown:

When ready to synchronize a copy project, click the Synchronize icon:

See Synchronization

Home Tab

The Home tab gives general zoom features, configurable shortcuts, properties and measurement tools.

The following tools are available in the Home tab:

• Zoom to Area

• Full Zoom

• Select Area

• Clone Area

• Configure Shortcuts

• Preferences

• Project Properties

• Select Ruler

• Micron Ruler
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• Pixel Ruler

• Calibrate

• Start/Stop Timer

• Task Log

• Manage Templates

Zoom to Area

Left click and drag a box around an area of interest. When satisfied release the mouse button and the overlay window
will be zoomed into that location.

Full Zoom

Returns the zoom level to the default setting.

Select Area

Click and drag to select an area that will be used in various Pix2Net features.
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This box acts as a boundary for the following tools:

• Count Cell Instances Cell Instance Search

• Set Review Boundary: Alignment Review

• Polygon Extraction Extract Polygons

• Filter Layer Filter Layer

• Identify Fill Blocks Extract Polygons (see identify fill blocks)

• Export Non-Overlapping Tiles Export (see non-overlapping tiles)

• Export Single Image Export (see single image export)

Clone Area

Creates a new image layer from the selected area of an existing layer.
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A confirmation window will pop-up giving the details of the new layer and the option to enter the name for this new
layer.

Configure Shortcuts

Brings up a window that allows shortcuts to be added or customized.
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Shortcuts can be organized by the category they belong to, command name or shortcut key(s) given. To add or change a
shortcut, click the existing shortcut or the whitespace in the Shortcut column then press the key(s) to bind this shortcut.
To clear all shortcuts, press the Clear button. Export will create a .csv file listing all of the current bindings that are
set.

Preferences

Displays the current default color scheme for various cell boundaries, nets, rulers and text markings.

124 Chapter 3. Reference



Pix2Net Documentation, Release 1.10.07

Double clicking any of these colors will bring up a color palette allowing a different color to be selected.

The user can change the ruler units. The following are available: auto, nano, micron, milli.

The Rendering Buffer Size allows the user to allocate as much or as little memory desired to the rendering (displaying)
of polygons.

Project Properties

Allows the user to change the name of the project and to enable condensed logging by choosing a path to the file.

3.1. User Interface 125



Pix2Net Documentation, Release 1.10.07

Select Ruler

Drag a box to highlight any unwanted rulers (micron or pixel).

Right clicking will bring a dialogue box with an option to delete selected rulers, or the user can simply hit the delete
key.
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Micron Ruler

Adds a micron ruler by clicking a start point and dragging to the endpoint. Press shift while dragging the mouse to
lock the ruler to be horizontal or vertical.

Pixel Ruler

Adds a pixel ruler by clicking a start point and dragging to the endpoint. Press shift while dragging the mouse to lock
the ruler to be horizontal or vertical.

Calibrate

Allows a layer to be rescaled to accurately match with known dimensions of a feature.
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To use this feature draw a line across a known length or width and enter the actual value in the Calibrate pop-up
window. This calibration can affect either the active layer or all layers in the project and either adjust the X-axis,
Y-axis or both.

Start/Stop Timer

When first pressed a timer will activate pressing this again will stop the timer and bring up a Task Log Entry window.
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In this window the start and stop times can be edited and the category, type of work and what layer was affected can
be chosen. The users name will appear and any notes may be added.

Task Log

This opens the task log window.

New entries can be added, any entry can be edited or deleted and the list can be exported as a .CSV list.
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Manage Templates

Brings up the Manage Templates window. This feature helps the user add, edit, remove, export, and import templates.
Templates

Capture Tab

The Capture tab allows you to connect a stage, a camera and set control features in Pix2Net to allow automated image
runs.

The following tools are available in the Capture tab:

• Stage

• Camera

• Spectrometer

• Control Microscope

• Setup Server

• Capture Config

• Start

• Stop

• Manual Move

• Rotation Alignment

• Capture Mode

• Create Capture

Stage
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The stage menu gives the following options:

Type: Select the type of stage you are connecting to.

Port: Select the COM port connected to the stage.

Sense: Set the direction of the stage movement (X, Y, and Rotation).

• Normal

• Invert with a check mark.

Cycle Power on Error: Allows Pix2Net to control a Power USB brand power strip that the stage is
plugged into. In event of an error, Pix2Net can cut power to the stage and reapply it, effectively rebooting
the device’s controller.

Home on Connect: Will cause the stage to execute a home-finding procedure as soon as you connect to
the stage. The stage must do this at least once per power-on state in order to know where it is. Homing
will cause the stage to physically move to its positive and negative limits, then return to the center. It is not
necessary to do it again if the user has just disconnected without removing power from the stage. Pix2Net
has no way to know what the state of the stage is on connection, so it relies on the user to tell it to home
or not.

Log Debug Info: Causes the Application Log to show all of the communication with the stage device. It
does not need to be turned on unless there is an error that needs troubleshooting.

Camera

The camera menu lets you link a camera with Pix2Net software.
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If a SEM is being connected a Pix2Net server must be created and set up properly.

If a Spot Camera is connecting no server needs to be created.

Spectrometer

Prior to beginning spectrometer scan, the sample must be measured.

After connecting the spectrometer stage, then the Spectrometer menu allows you to connect to the spectrometer con-
nected to the computer operating Pix2Net.

Using the Manual Move, position the sample into field of view.

Proceed to Create Capture

Control Microscope

Control Microscope brings up a user interface similar to a remote desktop that allows control via remote access. Using
control microscope features help verify that the commands specified in Setup Server are correct.
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The Control Microscope window can remotely do the following actions:

• Turn on the SEM beam.

• Turn off the SEM beam.

• Put the SEM in live capture mode.

• Pause the SEM capture.

• Capture one full scan on the SEM.

• Take an instantaneous screen shot of the SEM window.

Control Microscope can also adjust the dwell time, zoom, focus, X and Y stigmation, brightness and contrast using
the left and right buttons.

This window also displays the current magnification, brightness and contrast.

Setup Server
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Opens a window to setup a Pix2Net server that will control the SEM remotely. See the tutorial: Setting Up Pix2Net
Server

Capture Config

Capture Configuration lets you specify the parameters that will be used for an image capture run.

The General column records information that Pix2Net will use for the image run. This includes the width and length
of the area of interest, X and Y starting positions, and the pixel width

The Microscope column records information for future reference. This information is saved in the Capture History for
that particular layer

The Focus Settings column is used for making automatic adjustments to the focus of the sample to compensate for any
leveling issues.
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Start

When the start button the pressed a new image run will start using the Capture Parameters specified.

Stop

Stops the current capture. Capture can be continued using the Resume button.

Manual Move

Opens a panel that allows you to move the stage manually, and snap single images with the camera.

The X, Y, rotation, and stage velocity values can be entered manually and take affect when the green button is pressed.
The home button will return the Stage X and Stage Y values to zero, but will have no affect on the Rotate values.

A movement value can be entered in the Delta box and the six directional buttons will change the location or rotation
by the delta value.

The third column allows the user to set a focus point and go directly to it.

The last two icons give the status of the camera and stage. Once a camera is connected single images can be captured
by pressing the camera icon.
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Rotation Alignment

Opens the Rotation Alignment window. This feature acts as a wizard to help adjust the alignment of the sample. Follow
the on screen prompts to assist the tool in automatic alignment of the sample.

When the blue right button is pressed (the next step) this window will pop up:

Capture Mode

Allows the user to change between (turn on) image, spectrum, and measurement capture modes.
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Create Capture

Allows user to capture a spectrum image.

Prior to beginning the create capture, the sample must be measured in microns(um).

Click on “Create Capture” icon, “Align Spectrometer” window appears.

“Move Sample to Offset” - move sample to current existing offset

“Return Stage to Starting Position” - moves stage back to original position before using manual move in
“Align Spectrometer” window.

“Alignment Settings” - sets parameters for spectrum capture (see next steps).

“Create Capture” - starts the spectrum capture

Using the manual move within the “Align Spectrometer” window, move the cross-hairs to the center of the sample.

Click the “Correct Offset” button.
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Set the alignment settings.

“X Offset” - set when using manual move in “Align Spectrometer” window.

“Y Offset” - set when using manual move in “Align Spectrometer” window.

“Spectrometer Pixel Width um” - defaults to 300. Lower number achieves higher resolu-
tion and slower capture.

Higher number achieves lower resolution and faster capture.

“Camera Pixel Width um” - this number is determined by pixel width/size of device in um.

Click “OK”.

Click and drag a large capture area slightly past the area of the device.

Click “Create Capture”.
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“Capture Configuration” window will appear pre-populated with the information for the capture in the “General”
section.

Click “Save”.

Click “Start”.

Once spectrum capture is complete, you can process the data from the scan on the Spectrum Tab

Alignment Tab

The Alignment tab has features that deal with stitching images, moving layers and aligning one layer to another.

The following tools are available in the Alignment tab:

• Select Stitch

• Stitch Manager

• Regenerate Multiscale

• Move

• View Anchors

• Add Anchor

• Select Anchor

• Delete Anchors

• Align Anchors
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• Alignment Review

• Straightening Guide

• Polygon Alignment

Select Stitch

Selects the node where four tiles have been stitched together.

For more information, see: The Stitching Process

Stitch Manager

Opens the Stitch Manager window.

For more information on stitching and manual edits, see: Stitching

Regenerate Multiscale

The multiscale is a set of images that depict a layer when zoomed out. This makes zooming and scrolling operations
faster than if all individual tiles were displayed.

The multiscale needs to be regenerated if captured tiles are modified to update the zoomed out view.

Move

This tool moves the selected layer by clicking and dragging it.
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View Anchors

Opens the Anchor Groups window. Here all the anchor groups that have been created throughout the project are
displayed.

Once highlighted the anchors for that group are displayed in the overlay window.
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When the user selects M1 lines, the anchors for that group are displayed in the overlay window. It says only “M1
lines” instead of M1 lines - M2 lines because it is an orthogonal alignment.

To add an anchor press the + button and a window will pop up like this:
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The user then has to decide whether they want an interlayer alignment, a layer orthogonal tool, or a cell alignment
(these are talked about in aligning layers).

In the ‘Anchor Group Settings’, the user can specify if ‘Align Anchors’ should be performed after each ‘Add Anchor’.
This option should usually be turned on, but you can turn it off if the ‘Align Anchors’ process is taking too long.

The last button in the Anchor Group Settings is to copy the selected to a new anchor group with a different stationary
layer.

For more information on anchors, anchor groups and layer orthogonality, see: Aligning Layers
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Add Anchor

Adds a set of anchor points for the active anchor group.

Anchors are key in aligning two layers to one another
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Select Anchor

Click and drag a box over any unwanted anchors. The anchors selected will now be highlighted in red.

Delete Anchors

Click to delete any highlighted anchors. Only anchors that have been selected using the Select Anchor tool are affected
(The user can also use the delete key).

Align Anchors

If a bad anchor or group of anchors was removed the layer undergoing alignment will still be warped incorrectly.
Clicking align anchors will snap back to fit the unaltered anchor points.

Alignment Review

Alignment Review opens a window with features that assist in aligning one layer to another.
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Set Review Boundary: Use the Select Area tool in the Home tab to set a boundary of review points for
making the anchor grid.

Move to current: Moves the overlay window to center on the current alignment review point.

Accept: if the alignment does not need adjustment Accept will add an anchor at the review point.

Next: Move to the next review point.

Previous: Returns to the previous review point.

Calculate Bend Percentages: Under the Anchor Performance column a value is calculated for each anchor placed. The higher this value
the more warping the anchor caused.

Advance on New Anchor: Clicking this box will turn this feature on. Every time an anchor is placed or accepted the overlay will snap to the next
location an anchor should be placed for alignment consistency.

Straightening Guide

Displays a horizontal and vertical line that can be dragged around the screen. This tool is used to help verify the
orthogonality of each layer.

Polygon Alignment

Polygon alignment is controlled by the Polygon Alignment window in the “Alignment” tab.

This tool is used for any case that a polygon and a reference layer that were already aligned, get moved, or to tell
Pix2Net that the layers are aligned. Here’s what the polygon alignment window looks like:
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The tool will tell Pix2Net to set a reference layer to a polygon layer of the user’s choice. If the user sets the
reference layer to anything different from the polygon layer and it is not aligned, a message like this will appear:
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This should really only be an issue for existing projects. For future projects, the reference layer will be set when the
polygon layer is created, so the user should not see a dialog like this. Marking the polygons as ‘aligned’ means that
the user is saying that the reference layer is aligned correctly with the polygon layer. If the image layer is moved, the
next time the Polygon Alignment button is pressed, you will see “No” under the “Aligned” column. When you click

the button, it will align the polygons back to the reference layer. The aligned portion will then say “yes” and the
two layers will be aligned how they were before.

Image Tab

The image tab houses image related operations including polygon extraction.

The following tools are available in the Image tab:

• Layer Merge

• Filter Layer

• Transform Layers

• Extract Polygons

• Clear Polygons

• Training Images

• Neural Networks

• Extract Memory

• Export Bits

• Remove Image

• Image Settings

Layer Merge

The intent of the layer merge is to make one cohesive layer out of two or more existing layers. Turn on the layers to
merge, and make sure all other layers are off. Do this by toggling the visibility checkmark in the Layers window. (See
Layer Window)

Select Layer Merge and the window will pop up.
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The drop-down bar for Merge mode helps the user choose which type of merge they would like to see in the new
created layer. Once the mode is selected, the user can name the merge in the blank box. The Merge Layers button will
make a new layer without modifying the existing layers.

Filter Layer

Selecting the Filter Layer icon pops up the following window:
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Select the Layer to filter in the drop down menu.

The user can also select to preserve the original images or overwrite them after the layer has been filtered.

Use a profile listed. The profiles are created using Extract Polygons. See Extract Polygons

Click Filter to apply the profile to the layer. This will overwrite the viewing information (warped directory) so the
tiles look filtered in Pix2Net, yet the original data is maintained.

Transform Layers

The user can flip or rotate an entire image layer by using Transform Layers. This is useful if a layer is imaged in the
wrong orientation, or you would like to add a backside image to a data set that was imaged topside.

Clicking the Transform Layers button opens the Transform Layers Window:
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Click on the green + to pull up the Add Transformation Window:

The user may select between:

1. Flip Left to Right

2. Flip Top to Bottom

3. Rotate 90deg Clockwise

4. Rotate 90deg Counter-Clockwise
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Click Transform and all of the transformations will be performed in order for the selected layers, and a new layer will
be created.

Extract Polygons

Click the Extract Polygons Icon to open the Feature Extraction window.
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The upper left icon allows the user to load settings from another layer. This can help give a baseline
for the filters to apply.

To save the settings, click on the Save a copy of this profile icon . Enter a name for the profile and
click Save. Note, the extraction settings used are automatically saved.

For neural network via or line extraction, the user can add an image to the training set by clicking this

icon . Enter the name of the training set, or add the image to an existing training set. The Manage
Training Images Window will automatically pop up.

To manage the training sets, click on the Manage training sets icon . This will open the Manage
Training Images Window:
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To view the report click on the icon . Select between training sets to view the desired report.

The save icon allows the user to save a copy of the image. The user can save the original,filtered, or
edges of the image.

The Target layer is the layer that the feature extraction will be applied to. The user may want
multiple extractions from the same dataset, i.e. vias and lines extracted from the same images.

The Source layer is the image set used for the extraction.

The Extract menu allows the user to pick between extracting Lines or Vias. Via extraction
assumes bright white vias in the image.

Line Extraction

Min polygon size is used to filter out all noise with a width or length smaller than the
value entered

Smoothness sets the amount of pixel deviation that will be “smoothed” out when
extracting the polygons. The higher this number is, the fewer points drawn for each
polygon. If the number is too high, notches or jut outs will be lost in the extraction.
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Allow holes is checked when holes should be allowed in metal, and left unchecked
when the holes should be filled in due to delayering artifacts.

There are two methods of polygon simplification, Smooth and Straighten. Smooth is pretty
straightforward, the higher the smoothness the fewer points in each polygon. Keep an eye on
the preview, because there will be a threshold where there are too few points and the polygons
will not make good connection with other layers.

Straighten allows the user to extract polygons to look more orthogonal. The user inputs the
minimum polygon width, and can choose the standard option or the custom option. HIghlight-
ing each category will provide a brief description in the bottom left of the Feature Extraction
window.

Here the user can adjust the smoothness, noise reduction, noise threshold, square
corners, and minimum spacing.

Fill block settings are for fill patterns containing repeating rectangles of the uniform
size.

Identify fill blocks is checked to identify fill and place it on its own separate layer.

Expected width is the width of an average fill block in um.
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Expected height is the height of an average fill block in um.

Bounds tolerance describes the percentage of deviation allowed in the length and
width of a polygon to be considered as fill.

Deviation allowed describes the percentage of deviation allowed in the calculated
area of the fill blocks. (Meant to help when fill block shape is slightly irregular due
to deprocessing)

Add fill blocks to allows selection of a new or existing layer to add the fill block
polygons to.

Via Extraction

Method- Choose between edge detection and neural network.

Edge Detection

This algorithm attempts to identify vias by tracing the edge around white dots in the
image. The following parameters are used in this method:

Via diameter- This is the expected diameter of each via, in pixels.

Size tolerance- This is the percentage that the diameter is allowed to vary by.
For example, if the via diameter is 20, and the size tolerance is 10%, then
vias with diameters ranging from 18 to 22 will be identified.

Start edge- This is the minimum edge intensity pix2net will consider as it
looks for places to start tracing an edge that may turn out to be via. If this
value is too high, then Pix2Net will miss vias that are very faint. If this value
is too low, then it will take longer to extract vias, because the number of
edges that Pix2Net has to trace will increase.

Average edge- This is the minimum average edge intensity that a via must
have in order for it to be considered valid.

Circle similarity- This is how similar the shape of a via must be to a circle
in order to be considered valid. 0% means that all via shapes are allowed;
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100% means that only perfectly circular vias are allowed.

Brightness- This is how bright a via must be in order to be considered valid.
0% means that any via brightness is allowed; 100% means that only bright
white vias are allowed.

Output via size- This is the size of the via polygon that will be placed in
pixels.

Drop floating vias- When checked, select the metal layers above and below
the via layer to automatically drop any floating (not making contact with both
metal layers) vias detected.

How to extract vias using Edge Detection:

The best way to determine the correct values for these thresholds is to
use the “Show via report” feature. To do so, you must create a training
image. Here are the steps:

1. Click ‘Show polygons’. This will extract an initial set of vias with
the current settings.

2. Click the “Add image to training set” button. Enter a name for the
new training set, and then click “Ok”.

3. The “Manage Training Images” dialog will appear. Make sure that
the correct “Training Set” and “Training Image” is selected. Use
the “Add point” and “Remove points” tools to add missing vias and
remove extra vias. (Note: You can’t use “Undo” or “Redo” here).
When you’re finished, click “Close”.

4. Click the ‘Show via report” button. Make sure that you have the
correct image selected, and then click “Ok”.

The via report will list three statistics at the top: “Valid” is the number
of vias that were correctly identified, “Missing” is the number of vias
that were not extracted, and “Extra” is the number of edges that were
incorrectly identified as vias.

For each entry in the table, you will see its type (valid, missing, or
extra), its location in pixel coordinates, its size (the via diameter), the
edge intensity, the circle similarity, and the brightness. When you click
on an entry, you will see three views of the same area: The original
image, the filtered image, and the edge intensity image. You will also
see an “Edge points” list, which is the edge intensity at each point along
the via’s boundary.

If you want to figure out a good brightness threshold, for example, you
can click the “Brightness” column to sort the entries on brightness. If
you notice that all of the vias with a brightness below 70% are “Extra”,
and all of the vias with a brightness above 70% are “Valid”, then 70%
is definitely a good value to use for a “Brightness” threshold.
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Neural Network NOTE For a tutorial with a step-by-step process with pictures, please
see: Neural Network

The new method for extracting vias is to use neural networks. The nice thing about
neural networks is that you do not have to manually specify thresholds; you simply
have to create training images.

To create a training image, follow these steps:

1. With the “Method” to “Edge Detection”, click ‘Show polygons’. This will ex-
tract an initial set of vias with the current settings. Make sure that you note the
diameter of the via here, because you will need that information in step 6. If your
image contains black vias, you may choose to use an “Invert” filter for this step,
because the “Edge detection” method only detects white vias.

2. Click the “Add image to training set” button. Enter a name for the new training
set, and then click “Ok”.

3. The “Manage Training Images” dialog will appear. Make sure that the correct
“Training Set” and “Training Image” is selected. Use the “Add point” and “Re-
move points” tools to add missing vias and remove extra vias. (Note: You can’t
use “Undo” or “Redo” here). When you’re finished, click “Close”.

4. Click “Cancel” to close the Feature Extraction window.

5. Click the “Neural Networks” button to open the Mange Neural Networks dialog.
Click “Add Network”.

6. Set the “Via diameter” to the same value that you used in step 1. Click the add
button next to “Training Sets” to add the training set that you created. On the
right side of the window, you can now cycle through every via in each image
of the training set. You should now adjust the “Downsample” and “Patch size”
parameters:

Downsample is the number of times the image on the right will be zoomed
out. You should choose the zoom level that makes each via as easily recog-
nizable as possible.

Patch size is the size of the image on the right. You should try to make the
patch size as small as possible (so that the neural network runs as quickly as
possible), without making the patch size so small that the vias are no longer
easily recognizable.

When you’re finished tweaking the settings, click “Create”.

7. You have created the network, but now you need to train it. Select the network
and then click the “Start training” button. The neural network will be trained in
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the background. When you start training, the vias will be randomly divided into
a “training set” and a “testing set”. The “Training accuracy” is the network’s
accuracy on the training images, and the “Testing accuracy” is the network’s
accuracy on the testing images. In general, the “Testing accuracy” is the most
useful statistic, because that measures how accurate the network is on via images
that it has never seen before. The training will stop when the number of epochs
reaches 10. (An epoch is a single pass through the entire training set).

8. When the network is finished training, click the “View samples” button to visu-
ally inspect the results. You will see the following columns for each entry:

Sample - A unique number for each entry in the table Type - “Training” if
the sample was in the training set, and “Testing” if the sample was in the
testing set.

Confidence - A percentage, from 0 to 100, the describes how confident the
network is that it labeled the sample correctly.

Correct - This is true if “Network label” matches “User label”.

Network label - The label (“via” or “non-via”) that the neural network chose
for this sample.

User label - The label (“via” or “non-via”) that the user specified for this
sample in the training image.

Click “Close” to close the dialog.

9. Click “Close” to close the Manage Neural Networks dialog. Click “Extract Poly-
gons”. Change the “Method” to “Neural Networks”, and set “Neural Network”
to the network you just added. If you used an “Invert” filter in step 1, then
you should now remove that “Invert” filter, because the neural network has been
trained on the raw, unfiltered image, so that is what it expects as its input.

10. Click “Show polygons” to extract the vias using the neural network. Don’t worry
if vias near the edge were not identified; the neural network will not try to identify
vias at the edge, because it does not have enough context. If you notice that some
vias are missing, but the “Testing accuracy” was very high, then the problem is
probably not the neural network; the problem is probably in the algorithm that
determines which image patches are possible vias that should be passed to the
neural network. This is a known issue that will be fixed in the future.

Tile- tile being previewed in the four image panes to the right

Show polyogns- toggles the Polygons pane on or off.

Polygon color- click the square to select the preferred preview color

Fill color- click the square to select a color for the fill blocks when using identify fill blocks

The center section houses the applied filters for extraction. To add a filter click the green plus sign and
the Add Filter window will appear:
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Filters

The filters are sorted by four types - Pixel Transforms, Thresholding Filters, Smoothness Filters, and
Morphological Operations. Once the desired filter is added, highlight the filter to change the settings.

Pixel Transforms- filters that apply a formula to each pixel regardless of the surrounding pixels.

Brightness
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Negative values dim the image while positive values brighten the image.

Contrast

Negative values decrease the difference between pixels, while positive values will
increase the difference.

Invert
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This operation has no additional settings.

Histogram Equalization
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This operation helps balance image layers with inconsistent brightness and contrast
across their images. There are no additional settings for this operation.

Thresholding Filters- transform each pixel according to whether it is below or above a certain value.

Threshold
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Type is a drop down menu allowing the selection of the different types of thresholding.
Threshold is the value between 0 and 255. Look at the Filtered pane to see the effect.

Otsu’s Method
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Otsu’s method produces black and white images using automatically detected set-
tings. There are no additional user settings for this filter.

Smoothness Filters- affect the rate of change of pixels across an image

Median Blur
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Window size is the number of neighboring pixels considered to calculate the median
value. Number of times allows the filter to run multiple times.

Gaussian Blur
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Bilateral Filter
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Sharpen
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Morphological Operations- morphs the shapes of bright pixels. Works best on binary images.
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Dilate

Erode
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Open
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Close
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As many filters as desired can be added. Once a filter is created it can be turned on and off by the check
mark. Once the desired results are obtained in the Filtered pane and the Polygons pane, click Extract to
extract the polygons.

For a tutorial over extracting polygons, please see: Polygon Extraction
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Clear Polygons

Clears the polygons of the selected layer in the Layers window. The following confirmation window will
appear:

Training Images

This will open the Manage Training Images window that can also be opened from the Extract Polygons dialog. Make
adjustments to the training set as needed and click close.
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Neural Networks

For a tutorial over using the Neural Network, please see: Neural Network

This will open the Manage Neural Networks window.

The user will need to click the green + sign to add a new neural network. The Create Neural Network window will
appear:
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Click the “Neural Networks” button to open the Mange Neural Networks dialog. Click “Add Network”.

Set the “Via diameter” to the same value that was used in creating the image set. Click the add button next
to “Training Sets” to add the training set that was created. On the right side of the window, cycle through
every via in each image of the training set. Adjust the “Downsample” and “Patch size” parameters:

Downsample is the number of times the image on the right will be zoomed out. Choose the
zoom level that makes each via as easily recognizable as possible.

Patch size is the size of the image on the right. Make the patch size as small as possible (so
that the neural network runs as quickly as possible), without making the patch size so small
that the vias are no longer easily recognizable.

Click “Create”.

The network is created, but now it needs to be trained. Select the network and then click the “Start
training” button. The neural network will be trained in the background.
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When the network is finished training, click the “View samples” button to visually inspect the results. The
following columns are present for each entry:

Sample - A unique number for each entry in the table Type - “Training” if the sample was in
the training set, and “Testing” if the sample was in the testing set.

Confidence - A percentage, from 0 to 100, the describes how confident the network is that it
labeled the sample correctly.

Correct - This is true if “Network label” matches “User label”.

Network label - The label (“via” or “non-via”) that the neural network chose for this sample.

User label - The label (“via” or “non-via”) that the user specified for this sample in the training
image.

Click “Close” to close the dialog.

Extract Memory

Selecting Extract Memory pulls up the extract memory window:
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For procedures on ROM extraction see Extracting Memory from Images

Export Bits

Select to export a .csv file containing the bits in the ROM.
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Remove Image

Click and drag over the images/tiles that need to be deleted. Make sure that the tile(s) that will be removed is (are)
correct, as it cannot be automatically undone.

Image Settings

The Original Image Format denotes the extension for the original tiles set. This will convert images from .png, .jpg,
.bmp to .png, .bmp, .jpg. The .png format is recommended to reduce the size of the dataset.

The Generated Image Format denotes the extension for images generated by Pix2Net. These are the images stored in
the warped and mulitscale directories. The recommended format is .jpg

Polygon Tab

The Polygon tab has features that deal with adding, editing and moving polygons to new layers.
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The following tools are available in the Polygon tab:

• Add Layer

• Set Color

• Set Pattern

• Select Area

• Freform Area

• Clone Area

• Select Polygons

• Move Polygons

• Clone Polygons

• Clone Array

• Add Line

• Add Rectangle

• Add Square

• Add Circle

• Add Polygon

• Erase Rectangle

• Erase Circle

• Erase Polygon

• Settings

• Polygon Operations

• Adjust Grid

Add Layer

Adds a new polygon layer to the project. A Create Image Layer Association window pops up. This allows the new
polygon layer to be associated with images and layer warp grid.
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Set Color

Changes the color of the active polygon layer.

Set Pattern

Sets the pattern for the active polygon layer.
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Select Area

Allows the user to select a rectangular area of polygons that will later be cloned (in clone area). This is different from
selecting and cloning polygons because once the selected area is cloned, everything that is selected in the area will
be cloned exactly to where the user places it. This includes all polygons and even blank space that will be cloned, so
make sure that whatever area that needs to be cloned does not have any unnecessary polygons. At the same time, make
sure that there are no necessary polygons within the space that the clone will be placed.

Freform Area
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This is the same as Select Area, but the user is able to draw out their own boundaries to choose what area will be
cloned.

Clone Area

This allows the user to take the selected area or freformed area and clone it anywhere by just clicking and dragging
the polygons to the correct spot. This also allows users to clone blank spaces (for when the extraction of polygons is
placed incorrectly over areas that should not have polygons) For an example, see Selecting and Cloning Areas

Select Polygons

Click and drag to select a single polygon or group of polygons

Move Polygons

With the selected polygons highlighted, click and drag to move that group to a new location.
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Clone Polygons

With the selected polygons highlighted, click and drag to copy that group to a new location.
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Clone Array

The Clone Array feature allows the user to create multiple copies of one or more polygons, each set placed a fixed
distance from the original/previous set in a specific direction. This ability is useful whenever a regular pattern of
polygons needs to be created by hand. For example, a grid of 100 squares could be created by creating a square,
cloning it 9 times right, then cloning that newly created row 9 times down.

To use the feature:

1. Use the select polygons tool to select all polygons which will be cloned. The Clone Array ribbon button will
become enabled.

2. Click the Clone Array ribbon button.

3. In the dialog which appears, specify the direction from the original the polygons should be placed, the number
of sets of cloned polygons to create, and the distance each set of polygons will be moved away from the previous
set. You can specify a unit for the distance value entered.

4. Click “clone,” and the polygons will be created.

Add Line

Left click anywhere in the overlay window to add a start point to the line, a second click adds the endpoint. After
adding the start point holding shift will force orthogonality. Hold Ctrl when the width of the line is determined to
adjust the height. Use Shift to keep the line perfectly horizontal, vertical, or diagonal. The thickness of this line can
be defined in the Polygon Settings window.
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Add Rectangle

Click and drag to outline a box when the left mouse button is released a rectangular polygon will be added to the active
layer.

Add Square

Left click in the overlay to add a square to the active polygon layer. The square size can be specified in the Polygon
Settings window.

Holding Ctrl before clicking allows the user to adjust the size of the square.

Add Circle

Left click in the overlay to add a circle to the active polygon layer. Hold Ctrl before left-clicking, and drag the mouse
to increase or decrease circle size, or adjust the size in the Polygon Settings.

Add Polygon

Left click in the overlay window to start adding points, once three or more points are connected, the polygon will be
added to the active layer.

Erase Line
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The same as Add Line, but erases a defined line instead.

Erase Rectangle

Click and drag to outline a box when the left mouse button is released any polygons inside the box will be deleted.

Erase Circle

Click in the overlay to erase a circular area of polygons. The size of the circle is dependant on the size of the last used
add circle tool.

Erase Polygon

Left click in the overlay window to start adding points, once three or more points are connected, the polygon will be
erased on the active layer.

Settings

The polygon settings windows allows adjustment to the line thickness, square size, and circle radius in microns. There
is also a setting to adjust the maximum polygon size

The max polygon size determines the maximum width and height of the polygons in the project. If a tool attempts to
create a polygon larger than this size, the polygon will automatically be split until its dimensions no longer exceed the
max polygon size. If this value is too high then polygon rendering and netlisting will start to become inefficient.

Select active layer to tell Pix2Net that when selecting layers, the user only wants to select the active layer. Select
visible layers to be able to select all visible layers with polygons. While using this feature, the user can only move
polygons (no cloning). Using the ‘Select Area‘ feature will only select the polygons that are highlighted in the ‘Layers‘
window.
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The user can also click on Use Grid to have Pix2Net place a grid on the overlay to help assist with pitch and scale
correction of devices. The grid spacing and origin can be adjusted for X and Y coordinates.

This is what will show on the overlay when Use Grid is selected:
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Polygon Operations

Clicking this button opens the Polygon Operations window. The left column lists the available polygon operations.
The right column gives the user options for each operation.

Creates a new polygon layer by performing a transformation on existing polygon layers. The operations are as follows:

• Straighten: Applies a filter to straighten polygons.

• Filter Out Fill Blocks: Applies a filter to identify.

• Eliminate Overlaps: Fixes overlapping polygons by union or elimination.

• Union: Generates a new layer by merging all polygons from two selected layers.

• Intersect: Generates a new layer by that consists of only the intersection of two selected polygon layers.
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• Subtract: Generates a new layer by subtracting one polygon layer from another.

• XOR: Creates a new layer by exclusive.

• Grow: Creates a new layer by expanding all the polygons by a specified amount.

• Shrink: Creates a new layer that shrinks all polygons by a specified amount.

• Conditional: Performs a conditional operation on the polygons in a layer.

• Check Vias: Generates a report for vias not well centered in polygons from a check layer.

• Proximity Check: Generates a report for polygons which are placed too closely.

• Thickness Check: Generates a report for polygons which are too thin.

• Reduce Precision: Reduces the precision of each polygon in a layer.

Adjust Grid

Once Use Grid is turned on in the settings, the user may adjust the grid by clicking and dragging the grid along the
overlay window. There will be a small white plus sign towards the upper left-hand corner of the image to help the user
adjust the grid accordingly.

More Information

For more information on placing polygons and what the user can do with them, click this link: Polygon Placement

Cells Tab

The Cells tab has features that deal with adding cells, editing cells and ports, creating netlists, adding search plans and
scanning areas for matching cells.

The following tools are available in the Cells tab:

• Cell Window

• Select

• Move

• Resize

• Cell Instance Search

• Add Cell

• Add Cell Instance

• Add Port

• Technology
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• Generate Diffusion

• Create Netlist

• Find External Ports

• Select Net

• Active Nets

• Show Schematic

• Truth Table

• Netlist Text

• Identify Cell

• Cell Search

• Single Cell Search

• Area Search

• Select Key Points

• Add Key Point

• Delete Key Points

• Options

Cell Window

This toggles the Project Cells window.
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This window shows library cells that have been added to the project as well as the cell hierarchy. Many netlist
properties and cell instance information windows can be opened from this panel: Project Cells Reference

Select

Using the select tool either click inside the desired cell or click and drag around a group of cells to highlight them.
With the cell highlighted, tools like move and clone can be used.

Move

With a cell highlighted, select the move tool. Clicking and dragging in the overlay will move the cell.
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Resize

The resize tool adds a node to each corner of the highlighted cell. Any of these nodes can be clicked and dragged to
resize the cell.

Note: When resizing a cell all instances of the selected cell are also resized.

Cell Instance Search

Allows user to view instances of all cells which are children of the active netlist and search for unique cell names.

The Cell Instance Search window will open in the bottom pane.

Click on the magnifying glass to search for a particular instance in the netlist. The overlay camera will zoom to the
instance.
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Click on the wand to annotate cell instances using the desired convention.

The drop-down option lets the user apply this to the cells in the current netlist or to all cells in the project.

Add Cell

Create a new cell by adding a rectangular boundary for the cell instance. Recommended the user should have cell
identification knowledge before placing cells.

Add Cell Instance

With a cell highlighted, click and drag to add a copy of this cell instance. This new cell will not add a new entry to the
Project Cells list and all ports and electrical properties are replicated.
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Add Port

With a cell highlighted and the Add Port tool engaged, clicking anywhere in the cell will add a port at that location. A
Add Port window appears to collect information about this new port.

This window displays the cell name, cell instance name, the net that the port will be added to and the coordinates of the
newly added port. Information about the port is included here including, the port name, the polygon layer associated
with the port and the type of port (input, output, VSS, VDD, ect.)

If the port is placed outside the cell boundary an error will appear. Click OK and be sure that the port is in the cell
boundary.

Technology

User determines the number of metal layers.
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Allows the user to define the metal layer (on the left) to the corresponding layer (on the right).

If the layers are correctly in order and defined correctly in the layers window, the user can click on Auto-Assign and
Pix2Net will assign the correct layers to their corresponding layer.

Generate Diffusion

Before using this feature, make sure that the Poly and Diffusion layers are defined in Technology. This allows the
user to easily create generated diffusion and generated transistor layers. When selecting this, the user has the option of
either generating diffusion within a cell or the whole layer. NOTE Diffusion layers need to be defined before finding
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transistors within a cell (which is automatically detected when creating a netlist for a library cell). Generating diffusion
tells Pix2Net to find where the diffusion layer intersects with the poly layer. Pix2Net shows the user that the generated
diffusion layer will be the diffusion minus the poly, and the generated transistor layer will be where the poly and active
overlap. For more information see Adding a Cell

Create Netlist

Select the cell to netlist. For selecting a cell see: Project Cells Window

Before creating a netlist, generate the diffusion for the layer.

Click on the Create Netlist icon to define a cell as a Library Cell, a Library Cell with Bulk, a Circuit Block, or a Custom
cell.
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Select the desired type. Typically diffusion and poly layers are only used in library cells and metal1 and above are
used in larger cells that contain routing information.

The newest feature, Library Cell with Bulk is for users that need to detect four transistors (rather than 3), and needs
both the P-Well and N-Well defined in Technology. This is used for analog circuits; it will allow the user to create
a netlist and view a schematic. Four transistor cells are not able to be simulated in Pix2Net, so the Netlist Text and
Identify Cell will not work for this cell.

Each instance of each cell can have it’s own netlist. Once the primary cell instance has been netlisted, the netlist
command will run without asking for the layer connections. It will simply use the same layers selected for the primary
instance.

If the cell instance already has a netlist the following message will appear:
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Find External Ports

Finding external ports will find all ports that enter or leave the selected cell. with the exception of the top cell.

Options for placing the ports are listed in the Find External Ports window.

Find External Ports

Select Net

When highlighted, the select net tool will highlight a net in the active netlist. Click on the polygon in the overlay
window to highlight nets in red.
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To change the default color see selected net in Preferences

Active Nets

When highlighted, the Active Nets window is open. It will be a tab under the overlay.
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Nets highlighted in the overlay will be selected in the Active Nets netlist. The left pane of the Active Nets window
contains the net id, name, number of ports, number of polygons, error state, net type, and errors. The right pane of the
Active Nets window lists all of the ports and cell information connected to the highlighted net.

The outline mode icon controls the selected net outline mode. Default is to show the net with the
layers filled in. When depressed, only the selected net outline is shown.

3.1. User Interface 203



Pix2Net Documentation, Release 1.10.07

The ignore errors icon ignores any errors on the selected net. The purpose is to give the user a marker
for nets visited that have false errors being reported.

The add filter icon filters out the nets by column and parameters set in the window:

The left window contains the list of nets. Here are the columns:

• Net: The name of the net.

• Ports: The number of ports in the net.

• Polygons: The number of polygons in the net.

• State: A green checkmark indicates no errors. A red x indicates at least one error.
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• Error: A short description of the net’s error.

If you click on a row, then the camera will zoom to the net and highlight it, and the right window will show the details
of the selected net.

The right window contains the list of ports for the currently selected net. Here are the columns:

• Cell Number: The number of the port’s cell.

• Cell: The name of the port’s cell.

• Instance: The name of the port’s instance.

• Port: The name of the port.

• Type: The port type: Input, Output, Inout, VSS, or VDD.

If you click on the right column, then the camera will zoom to that particular port.

Show Schematic

Brings up a window that shows the schematic for the active netlist. The window will open as a tab in the overlay.

When viewing a schematic in manual layout mode, the user can use the “select” tool in the “schematic” ribbon tab to
select some number of schematic cells. The user may then right-click on the schematic window and choose “move
components to new block.” This will replace the selected schematic cells with a newly created hierarchical block. All
of the nets connected to the old schematic cells will route to the new block, and you can double-click on the block to
enter it and see the cells that it now contains.

Note

The user can only show the schematic if synchronize mode is off.
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Truth Table

The Truth Table is the automatically created truth table of the circuit.

Netlist Text

This shows the user the functional verilog, component verilog, H functional verilog, spice, VHDL, and comma-
separated values for the active netlist.
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Identify Cell

Once a cell has been placed, its netlist has been created, and its external ports have been found, the user can press
Identify Cell and Pix2Net will figure out what type of cell it is. For more information on how to add a cell to a
netlist and identifying it, please see: Adding a Cell

Cell Search

Opens the Search Plans tool window:
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This window allows search plans to be added, deleted, modified or executed.

Pressing on the settings button will bring up the Cell Search Settings window:
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This allows the user to define the layer(s) that should be referenced while searching for similar cells, set settings for
key points, as well as defining which layer should be used for setting key points. On the right side, There is an edit
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settings button which will bring up the Advanced Cell Search Settings window, where the user can set various advanced
settings for cell searches. Under settings for image quality, it can be set at low, medium, or high qualities for images
(this will change the preset settings in the advanced settings). There is also a custom 1 and 2 setting so the user can
customize the advanced settings if the preset settings are not satisfactory.

For more information on search plans see: Performing a Cell Search (Scroll to step #8 for more information over key
points)

Single Cell Search

Draw a rectangular area that acts as the boundary for the selected search plan.

A pop-up will appear listing all cells in the selected search plan. Please see Performing a Cell Search for a detailed
tutorial on searching for cells.
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Area Search

Area Search searches for potentially multiple placements for each cell in your search plan, all within the area you
draw. This is different from Single Cell Searches because it allows the user to look for more than one cell.

Select Key Points

Allows the user to select key points within a search cell to delete incorrectly placed key points.

Add Key Point

Before adding key points

When doing a cell search, the user can add Key Points to tell Pix2Net to look for selected specific points when
searching for cells. In order to see key points, the user needs to have the “Cell Search” window open, and have one
of the cells selected in the list. (Double-clicking on that cell in the Cell Search window will take the user to the
correct place in the overlay.) Finally, the image layer that the key points were added to must be visible. If the key
points are not showing up, then the most likely causes are that the cell is not selected in the “Cell Search” window, or
the image layer the key points were added to is not visible.

To see key points, make sure that the cell is highlighted in the ‘‘Cell Search‘‘ window, key points are defined in the
settings of the ‘‘Cell Search‘‘, and the image layer is turned on.
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For more information, please reference: Performing a Cell Search

Manual Placement – The user can use the “select key points,” “add key point,” and “delete key points” tools in the
“cells” tab of the ribbon interface to manually manage key points within a selected cell which has been placed in a
search plan. These tools operate on the main overlay window, and allow you to define the important regions of a cell
image. For a tutorial on adding key points manually, please see: Adding Key Points Manually

Automatic Placement – If the user finds that placing a key point on every via yields good results, the user can instruct
Pix2Net to do this step (we recommend the automatic placement over manually placing key points). When defining
the cell search settings, define one or more image layers to use in the comparison. At this time, the user may also
specify a polygon layer with the “initial key points” setting. If the user has specified an initial key point layer, then
whenever a cell is added to the search plan, that cell will automatically be populated with key points according to the
initial key points layer. For each polygon on the initial key point layer which is within the cell bounds, a key point
will be placed at that polygon’s centroid. For example, if we create a search plan to search on M1 images, and set the
initial key point layer to Contact polygons, we will automatically get a key point at the center of each contact. To see
the key points, make sure the image layer is on. Here is an example of a cell on the M1 layer using Contacts as key
points (the small dots within the red squares are the key points).
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Delete Key Points

Once a key point or points are selected, clicking this will delete the key point(s) (or press the delete key).
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Options

Brings up the Cell Options window.

Allows the user to switch on and off the following options: to show ports in modules, to show cell boundaries in
modules, and to tell Pix2net to use a flat hierarchy.

Netlist Tab

The Netlist tab creates and manages netlists for all cells.

The following tools are available in the Netlist tab:

• Netlist Browser

• Create Netlist

• Netlist Connections

• Analyze Netlist

• Clear Netlists

• Select Net

• Active Nets

• Show Schematic

• Truth Table

• Netlist Text

• Logic Paths

• Short Finder

• Check Netlists
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• Find External Ports

• Identify by Truth Table

• Identify by Netlist

• Add Section

• Clone Cell

• Refine Placement

• Clone Polygons

• Golden Lib GDS

• Load 3D Netlist

• 3D Viewer

Netlist Browser

Brings up a window to show the user all the cells within the netlist. If a cell is double-clicked, the user is brought to
the cell in the overlay.

Create Netlist

Select the cell to netlist. For selecting a cell see: Project Cells Window

Click on the Create Netlist icon to bring up the window:
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Select the desired layers. Typically diffusion and poly layers are only used in library cells and metal1 and above are
used in larger cells that contain routing information.

Each instance of each cell can have it’s own netlist. Once the primary cell instance has been netlisted, the netlist
command will run without asking for the layer connections. It will simply use the same layers selected for the primary
instance.

If the cell instance already has a netlist the following message will appear:
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Netlist Connections

Defines the connections in a netlist. The connections can be updated for the active netlist from here. Choose between
custom, library cell, or circuit block netlist connections, as well as telling Pix2Net to detect transistors or not.

If updating a connection, a confirmation dialogue will appear.
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For a brief description see: Netlist Connectivity

Analyze Netlist

When highlighted, the active netlist will be updated in real time. If the netlist is very large, it is recommended that
Analyze Netlist is off while editing.

To view the netlist, click the Active Nets icon.

Clear Netlists

Clears all netlists in the project.

Set analyze to Enabled to re create all netlists. Set to Disabled to keep all netlists empty.

Select Net
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When highlighted, the select net tool will highlight a net in the active netlist. Click on the polygon in the overlay
window to highlight nets in red.

To change the default color see selected net in Preferences

Active Nets

When highlighted, the Active Nets window is open. It will be a tab under the overlay.
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Nets highlighted in the overlay will be selected in the Active Nets netlist. The left pane of the Active Nets window
contains the net id, name, number of ports, number of polygons, error state, net type, and errors. The right pane of the
Active Nets window lists all of the ports and cell information connected to the highlighted net.

The outline mode icon controls the selected net outline mode. Default is to show the net with the
layers filled in. When depressed, only the selected net outline is shown.
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The ignore errors icon ignores any errors on the selected net. The purpose is to give the user a marker
for nets visited that have false errors being reported.

The add filter icon filters out the nets by column and parameters set in the window:

The left window contains the list of nets. Here are the columns:

• Net: The name of the net.

• Ports: The number of ports in the net.

• Polygons: The number of polygons in the net.

• State: A green checkmark indicates no errors. A red x indicates at least one error.
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• Error: A short description of the net’s error.

If you click on a row, then the camera will zoom to the net and highlight it, and the right window will show the details
of the selected net.

The right window contains the list of ports for the currently selected net. Here are the columns:

• Cell Number: The number of the port’s cell.

• Cell: The name of the port’s cell.

• Instance: The name of the port’s instance.

• Port: The name of the port.

• Type: The port type: Input, Output, Inout, VSS, or VDD.

If you click on the right column, then the camera will zoom to that particular port.

Show Schematic

Brings up a window that shows the schematic for the active netlist. The window will open as a tab in the overlay.

When viewing a schematic in manual layout mode, the user can use the “select” tool in the “schematic” ribbon tab to
select some number of schematic cells. The user may then right-click on the schematic window and choose “move
components to new block.” This will replace the selected schematic cells with a newly created hierarchical block. All
of the nets connected to the old schematic cells will route to the new block, and you can double-click on the block to
enter it and see the cells that it now contains.

Note

The user can only show the schematic if synchronize mode is off.
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Truth Table

The Truth Table is the automatically created truth table of the circuit.

Netlist Text
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This shows the user the functional verilog, component verilog, H functional verilog, spice, VHDL, and comma-
separated values for the active netlist.

Logic Paths

Opens the Logic Paths window (tab) in the lower left:
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Click the plus sign to add highlighted nets to the Logic Paths list. The net will stay highlighted in the overlay in the
desired color as long as the net is checked allowing the user to view multiple nets at a time.
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click on the to open the input dialogue. Setting increasing values allows the user to follow a signal through all of
the cells it is an input to.

The green net is the original net, and the blue nets are the level 1 descendent nets.

Note: The paths created will not be saved when you close Pix2Net.

Short Finder

The shortfinder window opens in the lower left corner:
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Select a port that is part of the short then click set. Select the second port and click set. Click Update
Path. The shortest path between the 2 ports is highlighted.

Check Netlists

The following check netlist options are avaliable:
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Check instance consistency verifies that the netlist of each instance of a cell matches the primary instance netlist. This
will compare the instances of all checked cells in the right hand pane and will report a match to a different, checked
cell if there is an inconsistency.

Check database consistency verifies that the netlist doesn’t have any missing entries in the database that could cause
problems or inconsistencies in the netlist. Run this periodically if database inconsistencies or corruption are suspected.

Check polygon connectivity verifies that the polygons are connected and can send energy from one layer to the next.

To access the reports created, got to the View tab and click on the Reports button. This will open the reports in the
bottom of the GUI.

Find External Ports

Finding external ports will find all ports that enter or leave the selected cell. with the exception of the top cell.
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Options for placing the ports are listed in the Find External Ports window.

Identify by Truth Table

This will open the Identify By Truth Table window in the bottom pane.

To set the library of comparison, click the wrench. A drop down menu will appear:

After selecting the desired library, click the magnifying glass to run the comparison to the active netlist. A list of
possible matches will appear:
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The score shows the percentage of match. A 100% is the best possible. Select one of the 100, and click on the green
check mark to check it in. The truth tables show how the signals will map. The Cell Identified window will pop up.

Click copy to transfer the checked properties to the current cell. If the user finds a cell that is not in the library, the cell
can be added to the library by clicking on the book icon.A confirmation dialog will pop up:

Identify by Netlist

This will open the Identify by Netlist window in the bottom pane.

Set the reference library as done in the Identify by Truth Table, click on the magnifying glass to run the compare:
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The comparison with the highest score is the closest match. If one (or more) has 100, that is a perfect match. Click on
the green check mark to check it in, or on the book if you have found a new cell you would like to add to the library.

Add Section

Allows the user to add a section. This is used to place netlists into different sections. The sections are marked with
green and red dots (next to the cell name). The green dot shows the user what active section they are on, and the
red dot shows the user the other sections that were created. If the user right clicks on the sections in the Project
Cells window, they can set it as the active section or revert it to a normal cell.

Clone Cell

Allows the user to clone a cell. By selecting on a cell and then selecting Clone Cell the user can replicate the cell
exactly wherever the mouse is clicked.

Refine Placement

If cell ports are misplaced, refine placement tells Pix2Net to move the ports around to match up with correct polygons.

Clone Polygons

Allows user to clone polygons within selected cell(s).
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When using Clone Polygons in the Netlist tab, the user can tell Pix2Net to the exact polygons in any selected
cell. For example, if the user wanted the polygons on Active and Poly to be filled in every BUF cell, simply select the
cell in the left hand column and then the layer on the right hand column.

The user can also decide to clone the polygons to their source layers or their new layers.

Golden Lib GDS

Attempts to find the identity of a cell through polygons.
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Load 3D Netlist

Loads the selected netlist for 3D viewing.

3D Viewer

Once the 3D netlist is loaded, the 3D viwer will show the user the netlist in 3D. Hold the ‘W’ key to zoom in and the
‘S’ key to zoom out of the 3D image.

Here is a bird’s eye view of what one could expect a netlist to look like in the 3D viewer:

Side view:
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Schematic Tab

The Schematic tab creates and manages schematics for all cells.

The following tools are available in the Schematic tab:

• Show Schematics

• Net Browser

• Display Settings

• Select

• Select Net

• Block Manager

• Block Nets

• Logic Block Search

Show Schematics

Brings up a window that shows the schematic for the active netlist. The window will open as a tab in the overlay.
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Net Browser

Opens a window in the bottom panel that allows for highlighting, and zooming to a particular net in the schematic
window.
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The user can see the ports, types, and nets of each cell or hierarchal block.

Display Settings

Brings up a window for setting the colors used in the schematic window. These settings are saved in the global
database. You can restore the default colors at any time by clicking “Restore Default Settings”. “Hide Text at this
Zoom Level” will hide the text at the current zoom level, however, this is unnecessary in the schematic view.
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Select

This is the “Select Cell” button, which is in the Schematic tab for convenience. See Select.

Select Net

This is the “Select Net” button, which is in the Schematic tab for convenience. See Select Net.

Block Manager

Allows the user to create (and view) hierarchical blocks in the overlay window. This provides more detailed control
over schematic blocks, and allows the user to see all of the current blocks
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Block Nets

The Block Nets window is similar to the Active Nets window, but it only shows nets which are part of the current
hierarchical block. This allows the user to look at selected net ID’s to see each port and their state. Once Block
Manager is open, click on Block Nets to bring up a window.

This shows the user each Net and their ID. When clicked on, Pix2Net shows the user the cell ID, the cell, the instance,
the ports, and their types.
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Logic Block Search

NOTE Before searching for logic blocks, make sure that there is a working active netlist.

Clicking on Logic Block Search opens the following window in the bottom pane:

Clicking on the magnifying glass allows the user to search for logic blocks.

The Logic Block Search Settings window pops up:
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It is pre-populated with the last search performed. To search this again, click Search.

The icons in the top of the window allow for different search types. Pix2Net will retrieve the block information

from the Logic Paths (in the cells tab) window , the current selected cells , or the Schematic Block
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.

The most common way to retrieve block patterns is through current selected cells, and then to save the results as
schematic blocks.

To do this, select a pattern of cells (in the schematic window, or overlay) click on Search for Logic Blocks, then Get
Pattern from Selected Cells, after that click Search.
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Now, click on Save Results as Schematic Blocks to add a hierarchal block and sub-blocks to the block manager.

The search block can be cleared by clicking clear results icon. The user can save the current block search by clicking
the save icon in the Logic Block Search Window. This will pop up a dialog that will allow the user to enter a name
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for the block to be saved. Note that currently Pix2Net allows the user to save blocks with the same name without a
warning. The user can also load a saved pattern by clicking on the Load Pattern icon.

Spectrum Tab

Note This tab is only for users with a spectrometer.

The Spectrum tab lets the user take the pixelated information that is gathered from the spectrometer and view its
amplitudes and specific pixels.

Before proceeding, you will need to have collected a spectrum image from the capture tab. See: Capture Tab

The following tools are available in the Spectrum Tab:

• Amplitude Viewer

• Show Filters

• Select Pixel

• Normalize Area

• 3D Viewer

• 3D Settings

• Spectrum Structures

Amplitude Viewer

This shows the user the amplitude of the spectrum that was taken.

The Amplitude Viewer will be blank until a pixel is selected on the scan.

244 Chapter 3. Reference



Pix2Net Documentation, Release 1.10.07

Use this when there is a sample that is captured by the spectrometer and then Pix2Net will show you the amplitude of
the spectra through the time-domain (in ps) and the frequency-domain (in THz).

By right-clicking and dragging the mouse, the user can zoom into specific areas of each domain.

The user may also right-click once inside the viewer window and a small menu of options will pop up to choose from.

3.1. User Interface 245



Pix2Net Documentation, Release 1.10.07

Show Filters

Once this is pressed, the Spectrum Filters window will pop up.

The user can use this to filter spectrum settings accordingly.

Use Time Gate: allows user to select certain time width of the capture.

Use IIR Filter: sets frequency filters

Pass Mode:

Lowpass - filters out low frequencies

Highpass - (this should be the default) filters out high frequencies

Bandpass - selects range of frequencies

Bandstop -

Type: sets parameters to filter frequency

Butterworth - should be default

Chebyshev
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Bessel

Order: number of times filter function is iterated

Ripple:

Use Freq Cutoff:

Cutoff Setting:

Freq Cutoff - Freq domain = FFT of Time Domain

Select Pixel

When using this tool, the user can click on a specific pixel inside the spectrum image and the amplitude viewer will
show the time and frequency of just that pixel.

Normalize Area

Use this tool to select a specific portion of the pixels to view more information of that area.
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3D Viewer

Allows user to see 3D representation of spectrum scan.

Click and drag to move 3D image around.

3D Settings
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Time Start: selects starting point in Time Domain

Time End: selects ending point in Time Domain

Time Bin: histogram bin width in Time Domain

Intensity Start: start of the intensity range

Point Size: size of each point

Intensity End: end of the intensity range

Angle of Incidence: angle of the beam through the sample (45 degrees should be default)

Spectrum Structures

NOTE The user must normalize an area of the spectrum in order to set structures.

3D Viewer should be activated when setting spectrum structures.

Drop down menu is based on layers in project.
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Select layer in drop-down.

Click “Add”

Enter a name for the structure.

Select “Clear all values below”.

Enter percentage of measured intensity to be omitted.

Click “Add”.

Select the test structure from the list.

The filtered 3D image is now available in the 3D Viewer.

The user can also generate a range of structures.
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Selecting this function will generate 20 structures to choose from (<10 to >90).

Trusted Design Tab

The Trusted Design tab manages comparison to golden gds files.

The following tools are available in the Trusted Design tab:

• Import Golden

• Golden Compare

• Reports
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Import Golden

Opens a window to import the layer.

Golden Compare

Initiates the golden compare operation

Allows the user to add a comparison between a golden layer and fabricated layer.

Reports
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Opens the report in the bottom pane

This lets the user delete, export, and visualize each report.

On the right, it shows the user the warnings or errors, that can be deleted or ignored.

See the golden compare tutorial: Comparing a Layer to a Golden Layer

Types of Differences

In the following examples, the golden layer is blue, the fabricated layer is red, and the difference is yellow. The
tolerance used was 1 micron.

Extra Metal

When fabricated metal has no golden metal near it, as defined by the tolerance, then that area will be flagged as an
Extra Metal error.
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Missing Metal

When golden metal has no fabricated metal near it, as defined by the tolerance, then that area will be flagged as a
Missing Metal error.

Bridge

A bridge is when one extracted polygon overlaps two or more golden polygons. This error is always detected, regard-
less of the tolerance setting.
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Gap

A gap is when one golden polygon overlaps two or more extracted polygons. This error is always detected, regardless
of the tolerance setting.

Errors and Warnings

Differences are either considered errors or warnings. In general, differences are flagged as warnings if the highlighted
area is smaller than the tolerance.

Labels Tab

The Labels tab creates and manages labels for non port type labeling of the design, including memory bits. See Extract
Memory

The following tools are available in the Netlist tab:

• View Labels

• Add Label

• Select Label

• Edit Label

• Move Labels

• Delete Labels
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View Labels

The View Labels button opens a tab in the lower left corner of the GUI.

• To add a new label category press the green plus button and give the category a name.

• To delete a label category, highlight the category, then press the red minus button.

• Show labels in the overlay by having the box checked. Uncheck the box to hide labels in the overlay.

• Change the color of the label by clicking on the colored box and choosing the desired color.

Add Label

To add a label, press the Add Label button and click in the overlay in the desired location. The following window will
pop up:
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Select the label category in the drop down menu, type in the desired label text, and press Add.

Select Label

When highlighted, the Select Label function is active. Click and drag around the label of the highlighted category in
the overlay. The selected label(s) will turn red.

Edit Label

Select a label, the press the Edit Label button. The following window will pop up:

Enter the desired change to the text and press Save.
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Move Labels

Click and drag to move selected labels.

Delete Labels

Pressing Delete Labels will delete all of the currently selected labels. This operation cannot be undone.

View Tab

The View tab manages the visibility of panes in the Graphical User Interface.

The following tools are available in the Netlist tab:

• Layers

• Overlay

• Bookmarks

• Application Log

• Command History

• Task Manager

• Memory Usage

• Reports

• Stack Windows

• Tile Windows

• Close Windows
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Layers

Toggles the layers window. The layers window will open up in the top left of the GUI.

See Layers Window for a description.

Overlay

Toggles the overlay window. The overlay window will open up in the center of the GUI.
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See Overlay Windows

Bookmarks

Toggles the bookmarks window. The bookmarks window will open up as a tab in the upper left of the GUI.

The bookmarks window allows you to save your current location by clicking the add button. Your current location is
considered to be the micron coordinates the camera is currently focused on. You can also edit the name of the saved
location by clicking the pencil button and delete unnecessary ones by clicking the red x button.
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Application Log

Toggles the Application Log. The log will open as a tab in the bottom center of the GUI. This log tracks errors in the
software.

Command History

Toggles the Command History. This window will open as a tab in the lower left of the GUI. The history tracks only
synchronizable commands.

The button on the left allows the user to filter a specific number of commands, or commands at a certain time. The
right button shows the statistics of commands - commands by type and by user.

Task Manager

Toggles the Task Manager. This window will open as a tab in the bottom center if the GUI. The Task Manager tracks
the progress of Pix2Net tasks and is especially useful for long running tasks.
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See Task Manager

Memory Usage

Brings up the Memory Usage window. This tells the user how much Java memory has been used and what the
maximum java memory is. Also allows the user to force garbage collection.

Reports

Toggles the Reports window. This window will open as a tab in the bottom center.

The left side of the Reports window lists all of the available reports, and the right side shows the highlighted report
(click on an entry to move to it in the overlay). The user can also click on the magnifying glass on the left side to
visualize the selected report as a polygon layer.
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Stack Windows

Stacks the windows in the overlay. The netlist-properties open in the overlay stacked by default.

Tile Windows

Tiles the windows in the overlay.

Close Windows

Closes the overlay windows.

Help Tab

The Help tab contains links to the html and pdf versions of the manual. About shows the current version of the
software.

3.1.2 Task Manager

The task manager shows the currently running tasks. You can cancel running tasks. You may also clear finished or
canceled tasks.
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3.1.3 Status Bar

The status bar is located at the bottom of the application window. It is divided into four areas. From left to right, it
displays:

• A progress bar that represents the overall status of the task manager, if at least one task is running. You can click
on this area in order to see the task manager.

• The micron coordinates of the area the mouse cursor is currently hovering over.

• The image tile the mouse cursor is currently hovering over.

• The cell instance the mouse cursor is currently hovering over.

3.2 PCB Tab

The PCB tab controls the printing circuit board prober stage.

NOTE At the moment, the Pix2Net system can only use the PCB prober with a Huntron dual-head probing station.
The user also must make sure that the right Capture Mode in the Capture tab is on the correct setting according to
what is will be captured (image or measurement). The Huntron is compatible with the Semiconductor Characterization
System, which applies current to one of the probes while the other reads the voltage. It is also compatible with the
Digital Serial Analyzer, where TDR applies voltage and reads it back.

The following tools are available in the PCB tab:

• Prober

• Manual Move

• Algin Prober

• Move to Point

• Grid of Ports

• Plot

• Capture Config

• Start

• Stop

3.2.1 Prober
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Allows the user to connect to a prober. When the prober is pressed, this menu will pop up:

Prober type: Huntron or simulated Device type: DMM, Keithley4200, or DSA8200 Device address: (Addresses of
connected devices)

NOTE To take measurements of connectivity through pins, the user must have the Keithley4200 or DSA8200 con-
nected to the Huntron and selected on Pix2Net. Capture the measurement and view in plot, or use manual measure-
ment. This is a similar example of what one might expect to see.
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3.2.2 Manual Move

Once the prober is on and hooked up, the user can manually move the prober in units of microns. This window will
appear at the bottom of the screen.

In the first box of numbers and pictures, there are X, Y, and Z (1 and 2) coordinates. These will tell the probers where
to be on the board in a 3D axis. The green stop sign tells Pix2Net to send the probers to those coordinates. The wand
will allow the user to make a manual measurement. The picture with the home will move the probers back to the home
position. The wrench will allow the user to adjust the prober settings. The 2 squares next to each other will create an
image capture with the current position as the origin. The Z1 and Z2 boxes control the individual probers. The user
can move up, down, left, and right along the board in X, Y coordinates, as well as up and down on the board in Z
coordinates. The camera in the top right corners of the boxes will allow the user to capture an image.

3.2.3 Algin Prober

Allows the user to re-align the prober stage. When this is pressed, the Align Prober window will come up at the bottom
of the screen.

Click on Probe Alignment tool and press in the overlay to set alignment points. When the user left-clicks in the overlay
where the alignment point will be, a window with a closer up picture will ask the user to point out exactly where the
point will go.

3.2. PCB Tab 267



Pix2Net Documentation, Release 1.10.07

3.2.4 Move to Point

To use this feature, make sure that the alignment process (see above) has been completed. This tells the prober head
to move to the position that was clicked in the overlay.
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3.2.5 Grid of Ports

Allows the user to draw a grid of ports. The user must have a Cell Instance selected in the Overlay to activate this tool.
When Activated the user can draw a box. Each of the corners of the Box will be the bounds of the port grid.
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You will be prompted with a dialog that will have two spinners for the number of Columns and Rows. Entering this
information and hitting OK will populate all Cell instances will a grid of Cells.

3.2.6 Plot

Shows the plot of the resistance curve or TDR curve of cells. Clicking Plot will bring up this window at the bottom of
the screen.

When a cell is selected and ports are placed, Pix2Net and the prober can make a sweep plot of the cell.
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3.2.7 Capture Config

Opens the Capture Config window:

Allows the user to choose which areas to capture, as well as adjust the major and general settings.

3.2.8 Start

Starts the prober
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3.2.9 Stop

Stops the prober

3.3 Projects Basics

3.3.1 Project Directories

The directory structure of an example project:

3.3.2 Technology

This dialog is used to configure the properties of the target device. These properties should be filled out before updating
the netlist or running cell identification.
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In the Layers section we will identify four special polygon layers: Metal 1, Polysilicon, P Diffusion and
N Diffusion. The cell identifier will use these layers to search for transistors.

Note: Legacy projects will need to regenerate a new diffusion by following these steps:

Click Generate Diffusion to have the software create a new layer. Generate Diffusion

The new layer is called diffusion minus poly, but it can be renamed to whatever you see fit. Use the
diffusion minus poly layer under the Generated Layers section of the Technology
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3.3.3 Netlist Connectivity

In the Connections section, the connections between layers are specified. When Pix2Net generates a netlist, it uses
the connections to determine if polygons on different layers may touch or not. For example, if you specify m2, via
m2 vias, m3, then that means polygons in the m2 and m2 vias layers may touch each other, and polygons in the
m2 vias and m3 layers may touch each other. Connections can be disabled for debugging purposes. See also Netlist
Connections

3.4 Importing and Exporting

3.4.1 Importing Existing Images

In order for Pix2Net to import a set of images, the following requirements must be met:

• The images must be contained in a single directory.

• The images must overlap (ideally by 10%).

• The images must have a number in their name that specifies the order they were captured in.
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• The images must all be the same size and in the same format (BMP, TIFF, JPEG, or PNG).

You will be asked for the number of columns, the number of rows, the overlap percentage, and the pixels per 𝜇m. If
you don’t know the pixels per 𝜇m, you can put in a dummy number, but keep in mind that the ruler will only be as
accurate as the pixels per 𝜇m is.

1. Open the desired project or create a new project.

2. On the file tab click Import, and select Multiple images.

3. Browse to the directory where the images are stored and click the Open button.

4. Fill out the fields in the Import Layer dialog and click the Import button.

5. The images will be copied into the project directory (a progress bar is not shown), and then a set of multiscale
images will be generated (a progress bar is shown).

After the multiscale generation completes, the new image layer is visible. However, the image layer will not look good
until the tiles are stitched.

3.4.2 Importing

The General tab:
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Name: name of the image set (in Pix2Net)

Rows: number of rows

Columns: number of columns

Resolution: image resolution in pixels/um

Overlap: overlap percentage

The Filenames tab:

When not using the Pix2Net capture feature, this tab helps the user sort out pictures in the order that is
needed.
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Pattern: Choose between Index, X Y, or Y X.

Ignore Prefix: If the

X and Y Order: When collected, choose how the images are raster Left to Right, or Right to
Left (X); Top to Bottom, Bottom to Top (Y).

Start Index: number of first tile

The Orientation tab:
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Add orientation transformations by clicking the green plus sign.

Flip Left to Right

Flip Top to Bottom

Rotate 90 degrees Clockwise

Rotate 90 degrees Counter-Clockwise

The Crop tab:
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Crops the image as it is imported by the number of pixels specified on each edge.

The Split tab:
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Allows the user to split each tile into smaller tiles and is able to divide the tile’s width and
height by a certain number.

Pix2Net layer form existing project. . .

Imports a layer from an existing Pix2Net project.
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Select the desired layer(s) from the list.

In order to import a multiscale image set into a Pix2Net as a layer, perform the following steps:

1. In a Pix2Net project, use the Import Multiple Images feature. Point it at the directory you saved the images in.
Do not select “stitch after import” or “allow gaps.”

2. Under the general tab, fill out the settings.

1. Name – The name to use for the new layer

2. Rows – Calculated by dividing the total number of images by the number of columns (see ‘c’ below).
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3. Columns – The number of multiscale images that make up a single row. Determine this number by looking at
the first image and counting until the image displays the end of the first row.

4. Resolution – The pixels per micron of the multiscale layer. This value determines the scaling to use for micron
rulers and the size legend on the overlay. If you’re just using Pix2Net to view the multiscale image, you can
ignore this value, but the rulers will be incorrect.

5. Overlap – For importing multiscale images, set the value to 0%.

3. Under the filenames tab, fill out the settings (see attachment for example).

1. Pattern – For multiscale import, set this to “Y X”

2. Ignore Prefix – For multiscale import, set this to the first part of the filename for the images being imported. For
example, “IL01”. This must be correct, or the import will fail.

3. X Order – For multiscale import, set this to “Left to Right.”

4. Y Order – For multiscale import, set this to “Top to Bottom.”

5. Start Index – For multiscale import, set this to 0.

4. Click the “Import” button.

Edited images. . .

Split image into tiles. . .

Indexed tiles. . .

GDSII file

Converts a GDSII file into a set of Pix2Net layers, and then adds those layers to the project.

Pix2Net layer from images

Creates a new image layer from a set of sequentially numbered images on the file system, which have been captures
by SEM. A dialog window will appear to allow complex configuration of the import process to match the format of
your images.

Pix2Net layer from existing project

Copies one or more Pix2Net layers from an existing project to the currently open project.

3.4.3 Exporting

Exporting GDSII
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Check the layer(s) to export. Double click under Layer or Datatype to add numerical information.

Export All selects all layers. Export None deselects all layers.

Add pmos marking layer: Checking this adds a small box of ‘pmos’ to the active to help distinguish
between n-type and p-type diffusion

Restrict to selected cell instance: The gdsii layers will be exported within the boundary of the selected
cell. When left unchecked, gdsii of the entire area is exported

Export cell placements: Exports cell boundaries as a layer

Export text labels: allows selecion between exporting labels on a new layer, an existing layer same
datatype, or an existing layer with a new datatype.

Output Filename: Specify where to store the gdsii file, and how to name it.

Exporting EDIF
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Exporting Gerber
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Exporting ODB++
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Exporting Library Cell Catalog
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Exporting BOM
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Exporting Cell Images
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Select the desired cells. Select the desired layer. An image will be exported for each cell/layer combina-
tion.

Exporting Cells
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Exporting Cell Instances
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Select the desired column headings. The result is a .csv file of all cell instances in the project.

Exporting Port Instances
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Exporting Complete Netlist
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Exporting Active Netlist
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Exporting Library Cell Netlists
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Exporting Overlapping Tiles
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Export Non-Overlapping Tiles
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Exports the layers as a data set of non-overlapping images

Export Single Image
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Exports the selected layer as a single .bmp file. Beware that very large layers will result in a .bmp file that
is too large to open.

Export Spectrum Layer
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Export Probe Measurements
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3.5 Stitching

The stitching system is used to stitch a set of tiled images into a single mosaic.

3.5.1 The Stitch Manager

The Stitch Manager is used to control the stitching process. It can be opened by pressing the Stitch Manager button in
the Alignment tab.
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The combo box at the top is used to select the active image layer from the list of visible image layers. There are four
buttons under the combo box:

• Stitch - Starts the stitching process for the active layer. During the stitching process, this button turns into a stop
button.

• Clear Stitch - Clears the stitching information that is associated with the active layer.

• Open Stitch Viewer - Opens the Stitch Viewer window, which can be used to visualize and edit the selected
stitch object.

• Settings - Opens the Settings dialog for the Stitch Manager.

The rest of the window is used to show the list of stitching errors. If the layer has not yet been stitched, then this list
will be empty.

Whenever the Stitch Manager window is open, a stitch grid for the active layer will be displayed in the overlay:

The grid will initially be white, but during the stitching process, the lines and dots will turn green or red.
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3.5.2 The Stitching Process

To start the stitching process, press the Stitch button in the Stitch Manager. The stitch grid will change colors through-
out the stitching process. During the stitching process, it is perfectly fine to change the active layer or close the Stitch
Manager window. The stitching process will continue to run in the background, even if the stitch grid is not displayed
in the overlay.

Once the stitching process is complete, the stitch grid can be inspected with the Stitch Viewer. First, a stitch object
must be selected. A stitch object can be selected by using the Select Stitch tool:

After activating the Select Stitch tool, click on a line or dot in the stitch grid to select it.

The lines in the stitch grid represent tile pairs, which are two tiles that share a common edge:

The dots in the stitch grid represent tile quads, which are four tiles that share a common corner:

Finally, click on the Open Stitch Viewer button to start viewing the selected tile pair or quad.

3.5.3 The Stitch Viewer

The Stitch Viewer has three modes: Tile Pair mode, Tile Quad mode, and Row/Column mode.

Tile Pairs

If a tile pair is selected, then the Stitch Viewer will start in Tile Pair mode:
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The purpose of the Tile Pair viewer is to allow the user to view the results of searches that were run during the stitching
process, and to allow the user to run their own searches. What is a “search”? In the stitching system, a “search” is
when Pix2Net attempts to find valid stitch points for a pair of tiles.

Clicking the Search button will bring up the Search dialog:
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There are two types of searches: Broad and Targeted. The purpose of a broad search is to determine if there is only
one possible way to stitch a tile pair or not, and if there is, to find that stitch point. The purpose of a targeted search is
to find the best stitch point near a target point.

Let’s start with the broad search. A search always has a major axis, which points in the direction of stage movement,
and a minor axis, which is perpendicular to the major axis. Since we are dealing with a vertical pair of tiles, the major
axis is the Y axis and the minor axis is the X axis.

The most important part of the broad search is defining the search boundaries. If we assume that there is some overlap,
then there are two possibilities: Either the top tile’s lower-left corner is overlapping with the bottom tile’s upper-right,
or the top tile’s lower-right corner is overlapping with the bottom tile’s upper-left, as shown in this figure:

304 Chapter 3. Reference



Pix2Net Documentation, Release 1.10.07

In a broad search, the “minimum overlap” and “maximum overlap” determine the worst case scenarios for both cases.
A broad search will perform two tests: In the first test, it will take the bottom tile’s image in the “minimum overlap”
scenario of case 1 (the “template” image), and it will try to find it in the top tile’s image in the “maximum overlap”
scenario of case 1 (the “reference” image). In the second test, it does the same thing, but for case 2. If these two tests
produce only a single stitch point, then the broad search has successfully determined that there is only one way to
stitch these two tiles. However, if the broad search finds either no stitch points or multiple stitch points, then the broad
search’s result will be considered invalid.

The “maximum slice length” in each axis determines how the template image will be sliced up. The reason that a
template image is divided into slices during a search is because, if either tile is warped, it may not be possible to find
the entire template image in the reference image. The default parameters will divide the template image into three
slices along the minor axis.

The “minimum correlation” determines the lowest amount that a template image is allowed to match a reference
image and still be considered valid. If there are multiple places where a template image matches a reference image,
then “correlation margin” is used to determine if the lower correlations are real matches or not. For example, if the
highest stitch point has a correlation of 98%, and the “correlation margin” is 2%, then another stitch point of 97%
would also be considered valid (because it is 1% away from 98%), but a stitch point of 95% would not (because it is
3% away from 98%).

The “distance penalty” doesn’t make sense for a broad search, so it should always be zero. The “maximum warp” is
the percentage of tile width that the stitch points of the slices are allowed to vary from each other, under the assumption
that the tiles can’t possibly be warped enough for both of those slices to be correct. For example, let’s assume a tile
width of 2048, a “maximum warp” of 1% (i.e. about 20 pixels), and a slice with a stitch point at 0, 1591. In that case,
a second slice point at 0, 1593 would be considered valid (because it is only 2 pixels away), but a third slice point at 0,
1621 would be considered invalid (because it is 30 pixels away).

A targeted search, on the other hand, always returns the best set of stitch points it can find. A targeted search requires
the user to specify two target points, at opposite sides along the minor axis. In the case of a vertical tile pair, the first
target point is specified on the left side and the second target point is specified on the right side. Pix2Net then chooses
a target point for each slice by interpolating between the two extremes. Finally, the “Allowed Error” determines the
maximum distance, as a percentage of tile width, that a valid stitch point may be from the interpolated target point.

The targeted search will always return the stitch points with the highest correlation, provided that correlation is higher
than the minimum correlation and the slices are within the “maximum warp” constraint. There is just one exception: If
the “distance penalty” is greater than 0, then the correlation at each possible stitch point will be adjusted by subtracting
the distance penalty times the distance from the target point. The distance penalty is very important for tiles that have
many valid stitch points, because the distance penalty will force Pix2Net to lean towards stitch points that are closer
to the target point, instead of choosing stitch points solely based on their correlation.

At the top of the Search dialog, there is a “Load settings” button. This button can be used to populate the Search dialog
with the standard settings used in each pass during the stitching process. Here are the three passes the occur during
the stitching process:
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• Pass 1 - In this pass, a broad search is run on each tile pair in order to find a list of known stitch points for each
row and column.

• Pass 2 - In this pass, the list of known points found in pass 1 are used to find a line of best fit for each row and column. This line of best fit
is then used to run a targeted search, with 3% error and 0% distance penalty, on each tile pair.

• Pass 3 - In this pass, the tile pairs that still have invalid stitch points are fixed by running a targeted search with 1% error and a 0.1%
distance penalty. The assumption is that the searches that failed in pass 2 are the searches in which
distance needs to be considered, instead of just looking at the correlation.

That covers the search button.

The table on the lower left, beneath the Search button, shows the list of results from the various searches that have
been run. It also includes a Verification result, which will be covered in just a little bit. For now, click on a “Pass 2” or
“Pass 1” result to see what a search result looks like.

The Clear button can be used to clear the selected search result. The Left Quad and Right Quad buttons are equivalent
to selecting the left or right quad in the stitch grid. The Row/Column button will put the Stitch Viewer in Row/Column
mode, so that the user can see how this pair’s stitch points compare to the other stitch points along the same row or
column.

The table on the lower right contains the list of stitch points for each slice in the selected search result. For targeted
searches, the combo box above the table will always be “Correlation”, but for broad searches, it can be changed to
“Test stage moved left” or “Test stage moved right”, to specify which of the broad search tests to view.

The table will always contain an entry that does not have an “X” or “Y” coordinate, which is selected by default. This
entry is an overview of the slices. It shows the two tiles separately, with a green rectangle around the template image,
and a yellow rectangle around the reference image. It also shows a mosaic on the right, which is generated from the
stitch points of the valid slices.

Clicking on the other entries will show the template and reference rectangles for that particular slice. It will also show
a correlation image, which has darker pixels for the low correlations and brighter pixels for the high correlations. If
the user hovers the mouse over the image, then the corresponding correlation value is displayed in the status bar. For
targeted searches, a green dot represents the target point for the slice (for broad searches, the green dot is meaningless).
For targeted searches, a red dot represents the best correlation point. For broad searches, a single red dot represents a
valid stitch point. The lack of a red dot indicates no valid correlation points were found, and two red dots indicate that
there are at least two possible ways to stitch the tiles.

A mosaic shows the template image on top of the reference image at the highest possible correlation point. Finally,
a difference image shows the distribution of the differing pixels between the template and reference images. The
smallest differences are represented by dark pixels, and the largest differences are represented by white pixels.

Finally, the Verification entry in the lower left table is a special correlation that the stitching process runs on the final,
warped tiles. If any new searches are run, the verification entry will immediately vanish, because the final warped
images may have changed, so a new verification needs to be run. A verification consists of doing a correlation in
which the template image is divided into five slices, and the reference image is 3 pixels bigger than the template. The
“score” that the verification reports is the lowest correlation among the five slices. The “potential” is calculated by
looking at the worst slice’s current correlation score, and the highest score that can be obtained by moving template
image around by just 3 pixels. A verification with a low score and a high potential means that at least one of the tile’s
stitch points is definitely wrong.

Tile Quads

If a tile quad is selected, then the Stitch Viewer will be in Tile Quad mode:
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The purpose of the Tile Quad viewer is to show the user what four tiles look like, given the stitch points currently
defined. Clicking on the Row or Column button will put the viewer in Row/Column mode.

The score, which is displayed to the right of the Row and Column buttons, is calculated by checking the consistency of
the four tile pairs. A lower score is better; a score of zero indicates perfect agreement. A score of 5 or greater indicates
that the tile pairs disagree by at least 5 pixels, and the quad will be colored red in the stitch grid.

The stitch points for each tile pair are displayed in the table in the lower left. The user can visit any of these tile pairs
by double-clicking on them. The “Expected” column is the stitch point for each tile pair that would be required to give
the quad a perfect score of zero. If pass 3 finds a tile quad with 3 valid tile pairs and 1 invalid tile pair, then it will use
the expected point when it tries to fix the invalid tile pair.

Rows/Columns

The Stitch Viewer can be placed in Row/Column mode by clicking on the Row or Column buttons in the Tile Pair and
Tile Quad modes:
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The purpose of the Row/Column viewer is to visualize the trend of stitch points along a column or row. The top graph
represents the X values of the stitch points, and the bottom graph represents the Y values of the bottom graph. In both
graphs, the tile number is the x axis, and the stitch point’s X/Y value in pixels is the y axis. In this view, the tile number
is not the usual index of the tile in the layer, but instead, it is the index of the tile along this particular row or column.

In the lower left, the view can be changed from “Active Result” to “Manual”, “Pass 3”, “Pass 2”, or “Pass 1”, in order
to look at the results of a particular pass. The trend line, which is determined by the results of “Pass 1”, can be toggled
on and off.

The table in the middle contains all of the stitch objects along this row or column. The user can visit these stitch
objects by double-clicking on them.

3.5.4 Clear Stitch Grid

The Clear Stitch Grid dialog can be opened from the Stitch Manager:
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This dialog can be used to clear the stitch grid. It can also be used more selectively, so that only certain passes are
cleared, or so that only the warped tiles are deleted.

3.5.5 Settings

The Settings dialog can be opened from the Stitch Manager:
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The settings dialog controls the verifications that are shown in the Stitch Manager. By default, verifications are only
shown if they have a score lower than 97%, and if they are not along the border of the layer.

Another setting that can be changed is the type of stitch grid that is drawn. By default, the stitch grid is white when
stitch information is missing, green if stitch objects are valid, and red if stitch objects are invalid. However, if the stitch
grid is changed to Degree of Warp, then the colors will represent the extent to which tiles have been warped along their
edges. White indicates almost no warp, green indicates a small amount of warp, yellow indicates medium amount of
warp, and red indicates a large amount of warp.

The last feature to the Settings are the pass settings. The user can write what is wanted within each pass setting as well
as setting the maximum warp allowed for all passes.

3.5.6 Fixing Stitch Errors

During the stitching process, Pix2Net will run three passes. Each pass runs a search that returns a valid result (a
green line) or an invalid result (a red line). There are times when pass 1 and pass 2 return a red line, but that does
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not necessarily mean something bad happened; there are many times where pass 1 and pass 2 are supposed to return
invalid results, because it is expected that a later pass will find a valid result. Therefore, search results can be divided
into four categories: True positives, true negatives, false positives, and false negatives.

In general, false positives are much worse than false negatives in the stitching process. A false negative is simply
a piece of information that could be used, but is ignored by Pix2Net. A false positive, however, represents a bad
assumption that may be used by later passes, resulting in more bad assumptions and stitch errors. Therefore, the
search parameters for each pass have been chosen with two goals in mind: 1) Eliminate false positives completely and
2) avoid an excessive amount of false negatives.

Pass 1 Errors

If the stitching completes and a row or column has a large amount of red lines, that’s a pretty good sign that pass 1
failed on that row or column. In order to verify this, select a tile pair on that row/column, open the Stitch Viewer, and
switch to the Row/Column view. If you set the view to ‘Pass 1’, and you notice that the trend line is tilted due to some
outliers, then those outliers are most likely false positives.

In pass 1, a false positive is when pix2net believes there is only one valid way to stitch a tile pair, but there are in fact
either multiple ways to stitch the pair, or there is no valid way to stitch the pair. A false negative, on the other hand,
is when pix2net believes there is not a single valid way to stitch a tile pair, but there actually is only one valid way to
stitch the pair.

False positives are very bad, because it only takes one false positive to throw off a trend line. False negatives aren’t
nearly as harmful, because a false negative simply means there is one fewer data point to help guide the trend line.

Currently, there’s no easy way to simply run pass 1 with different parameters on an entire row or column, so fixing
the results of a pass 1 error may be tedious. Pix2Net tries to reduce the chances of a false positive by using a high
minimum correlation (98%) and a high correlation margin (.1%). On a side note, if pass 1 does not find any valid
stitch points along a row or column, then pass 2 will default to using an ideal trend line.

Pass 2 Errors

Pass 2 will attempt to stitch tile pairs along the trend line from pass 1. Pass 2 will use a distance penalty of zero, so
pass 2 will only work if the highest correlation point in each slice is the correct stitch point.

A false positive in pass 2 is when a search result is marked as valid, but the stitch points are actually incorrect. This
can happen if the highest correlation point in each slice is wrong, but the points are still within the allowed warping
distance, so each slice is consistent with the other slices. A pass 2 false positive is not as bad as a pass 1 false positive,
but it can still be pretty bad if a lot of nearby pass 3 stitches rely on it in order to generate their target points.

A false negative in pass 2 is when the highest correlation point in each slice does in fact represent a valid way to
stitch the pair, but pass 2 incorrectly marks the search result as invalid. This can happen if the tiles are so warped that
the resulting stitch points violate the maximum allowed warping distance. It can also happen if the slices have a low
correlation, due to charging effects or excessive tile warp. Pass 2 uses a minimum correlation of 95%, which is lower
than pass 1’s 98%. However, 95% may still not be low enough to prevent all false negatives.

In contrast to a false negative, a true negative in pass 2 is when a search result correctly identifies a situation where
the highest correlation point in each slice does not represent a valid way to stitch a tile pair. A good example of this
case is a pair of tiles that have nothing but horizontal white lines, or nothing but vertical white lines. There are many
possible, valid stitch points, so pass 2 will not be able to determine the correct way to stitch the pair. A pass 3 search,
on the other hand, will work, because pass 3 includes a distance penalty that can be used to sort the valid stitch points
by their distance from a target point.

3.5. Stitching 311



Pix2Net Documentation, Release 1.10.07

Pass 3 Errors

Since pass 3 has a low minimum correlation of 90%, and a distance penalty of 0.1%, it will almost certainly work if
valid target points are passed to it. However, the target points used may end up being invalid target points if they were
calculated from bad results from pass 2 or pass 1.

Also, pass 3 will only run searches on invalid pass 2 results. Pass 3 will not run on valid pass 2 results, because it does
not know which pass 2 results are true positives, and which results are false positives. This means that pass 3 will not
fix a red dot that is connected to four green lines, because pass 3 does not know which of those lines is a false positive.
However, you as a human may be able to determine this by selecting the red dot, opening the stitch viewer, and looking
at the row and column views. Look closely at the stitch points of the pairs that are adjacent to the selected quad. If one
or more of those stitch points seems to be out of place in comparison to its neighbors, then that is probably the false
positive. You may be able to fix this false positive by simply running a pass 3 search on it.

One final thing to notice is a difference between the way pass 2 and pass 3 choose their targets points. When pass 2
calculates its target points, it uses the trend line from pass 1. When pass 3 calculates its target points, however, it may
use the nearby pass 2 and pass 3 search results. Therefore, a pass 3 result may be bad because of other bad pass 3
results, but a pass 2 result will never be bad because of other bad pass 2 results.

3.6 Overlay

3.6.1 Overlay Windows

Overlay windows allow you to view and manipulate the layers in the project. The main layer window is the Overlay
window, but each layer also has an image window and/or feature window associated with it. The Overlay window
allows you to view multiple layers on top of each other. The Overlay window can be toggled on and off from the View
menu. The image windows and feature windows associated with a layer, on the other hand, are useful for viewing two
or more layers side by side. These windows can be enabled by the context menu in the Project window.

You can move around in the overlay window with the keyboard by pressing the A (left), D (right), W (up), S (down),
Q (zoom in), and E (zoom out) keys. You can also move around with the mouse. Hold down the middle mouse button
to move up, down, left, and right, and zoom in and out with the mouse wheel.

When a layer window has the focus, then you can use the arrow keys to move around. Each layer window has a ruler
in the lower-right corner that gives you a sense of scale.
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Right-click anywhere in the overlay window, then the following menu will pop up:

• Count cell instances. . .

– Allows the user to draw a box, and then tell Pix2Net will say how many cell instances are within that
box.

• Go to

– Coordinates: Allows you to enter specific micron coordinates to move the camera to.

– Tile: Allows you to enter an image tile number to move the camera to.

• Save

– Overlay as bitmap: Saves the overlay’s contents as an image in a folder specified by the user.

• Selected cell

– Flip left to right: Flips the selected cell left to right

– Flip top to bottom: Flips the selected cell top to bottom

– Rotate clockwise: Rotates the cell 90 degrees clockwise.

– Rotate counter clockwise: Rotates the cell 90 degrees counter-clockwise.

– Delete cell instance: Removes the selected cell.

– Delete cell (Exclude Children): Removes the selected cell, but leaves all children cells intact.

– Delete pattern: To use this feature, the user must have two cells selected. Delete pattern will ask
which cell to keep. Then, it will search the whole project for places where there exists the “pat-
tern” that the selected cells make together. If there was an ‘L’ shape of three different cells, it
would find all the places where that same ‘L’ is made of those same cells. Then, in every pattern,
it will delete all cells except the “keep” cell.

– Make port names uppercase: Changes the port names of the selected cells to uppercase.

– Make port names lowercase: Changes the port names of the selected cells to lowercase.

– Move to active section: Moves the selected cell to the active section.

– Identify as 0-bit: Defines the cell as a digital LOW or 0 bit.

– Identify as 1-bit: Defines the cell as a digital HI or 1 bit.

– Fill with memory grid. . . : Creates a memory grid array

• Selected port

– Edit: Edits the selected port.

– Remove: Removes the selected port.

• Selected polygon

– Flip left to right

– Flip top to bottom

– Flip clockwise

– Flip counter clockwise

– Remove: Removes the selected polygon(s).

– Move to layer. . . : Moves the selected polygon(s) to a different layer.

– Copy to layer. . . : Copies the selected polygon(s) to another layer.
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• Selected ruler

– Delete: Removes the selected ruler.

• Origin offset

– Clear: Clears the offset

– Set here: Sets the origin where the mouse was clicked.

3.7 Layers Window

The Layers window lists all of the layers that belong to the project. The selected layer is considered to be the active
layer. The active layer is the layer that will be targeted for manipulation whenever a tool is used.

Each layer has a set of controls next to it:

• A check box that can be used to show or hide the images associated with the layer.

• If applicable, a check box that can be used to show or hide the features associated with the layer.

• A color box that can be used to colorize the images associated with the layer.

• If applicable, a color box that can be used to colorize the features associated with the layer.

• A slider that can be used to change the transparency of the images associated with the layer.

The top of the layer window has the following buttons:
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• Show image layer: Opens a new layer window that will only show this layer’s image, regardless of what is
shown in the overlay window. If you open multiple layer windows, you can view them side by side by going to
View -> Tile Windows.

• Show polygon layer: Opens a new layer window that will only show this layer’s features, regardless of what is
shown in the overlay window.

• Show layer properties: Allows you to edit properties associated with a layer. This feature is not used very much
by Pix2Net just yet, but when you import GDS layers, the layer number and data type will be saved as properties.

• Move layer up: Moves a layer one space upwards in the stack.

• Move layer down: Moves a layer one space downwards in the stack.

• Remove layer: Removes a layer from the project, and gives you the option to delete any folders associated with
the layer.

• Hide/show all image sublayers: Turns on/off all image layers.

• Hide/show all polygon sublayers: Turns on/off all polygons.

If you right-click on one of the layers, the following menu will pop up:

• Rename: Renames this layer. The layer’s directory will be renamed as well.

• New polygon layer: Creates a new, empty feature resource for this layer. This is useful if you intend to draw
features by hand.

• Move Ports. . . : Moves all ports from the highlighted layer to another target layer.

• Move to Top: Moves the highlighted layer to the top of the list.

• Move to Bottom: Moves the highlighted layer to the bottom of the list.

• Display Cells: Displays the cells within the selected layer in the overlay and in the cell visibility window as a
quick filter.

• Reset Warp: Resets any warping that has been done to this layer.

• Fix Indexes: If layer indexes are not correct, Fix Indexes renumbers them.

• Lock: Allows you to lock changes to a layer’s alignment and polygon layer so they cannot be moved or changed.

• Columns: Allows you to show or hide column options in the Project window.
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3.8 Project Cells Window

3.8.1 Project Cells Reference

The project cells window also allows you to toggle the following windows:

• Cell Visibility

• Netlist Browser

• Cell Instances

• Flat Cell List

• Reference Cells

• Show Netlist Properties

• Move Into Target Netlist

• Move Out to Main Netlist

• Manage Electrical Models

The project cells window shows all of the cells in the project in a tree. You can toggle the visibility of a cell in the tree
by clicking on the green down arrow when the cell is highlighted. Right-click a cell to bring up the context menu:

• Show [cell] Only: Equivalent to selecting this cell’s check box, and deselecting the check box of every other
cell.
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• Show [cell] and Children Only: Shows this cell and is children, and hides the other cells.

• Move Into [cell] Netlist: Moves the user into the targeted netlist (same as pressing the green down arrow).

• Hide All: Hides all cells that are showing.

• Add Persistent Filter (show cell/show children): Shows the cell or both the cell and children.

• Rename [cell]: Renames the cell.

• Delete [cell]: Removes the cell, including its instances and ports.

• Delete Children: Deletes only the child cells of the selected cell.

• Delete Ports: Deletes the ports that were added to a cell.

• Edit Module: Allows the user to edit the module and electrical type of the cell. Modules can be filtered by
library, size, or number of ports.

• Pair Inputs: Brings up Assign input pairs window. The user can specify relationships between inputs by saying
that input A is the inverse or clone of input B. This is necessary if the cell expects there to be a relationship
between inputs, such as inversion. This is used for truth tables, state tables, and verilog.

• Edit Invalid States: Lets the user edit and add invalid states to cells. Choose to add an invalid state and if the
state should be x, 0, or 1.

• Electrical properties: Opens the electrical properties of a cell. Currently, these properties must be manually
entered.

• Section Actions (set as active section/revert to normal cell): Sets the highlighted section as the active one. Only
applies to Sections not Cells.

3.8.2 Cell Visibility

When this (the eye) is pressed, it brings up the Cell Visibility window:
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3.8.3 Netlist Browser

The cell netlist browser allows you to view the netlist of a selected cell. Generally there is only one netlist per cell
instance. If more than one netlist exists for a given cell you can see if any variations exists. Only one active netlist is
allowed and all netlist commands will only affect

3.8.4 Cell Instances

The cell instances window allows you to see the instances and ports of the cell currently selected in the Project
Cells window. When you select an instance in the table, the camera in the layer window will center on the instance
and highlight it with a blue box.

The instances table has the following columns:

• Name: The instance’s name. This field is editable.

• Parent: The instance name of the parent cell.

• Parent Cell: The name of the parent cell instance.

• ID: The instance number.

• Property: Shows the properties of the cell instance.

• Value: Shows the value of the properties.

• Port: Names of the ports.

• Type: Shows type of ports (input, output, VDD, VSS, etc.).

• Layer: Shows which layer the port is on.

The ports table has the following columns:

• Port: The name of the port.
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• Type: The port’s type: Input, Output, or Inout.

• Layer: The layer the port was placed on.

3.8.5 Flat Cell List

The flat cell list window shows you a flattened list of all of the cells in the project. The following columns are
displayed:

• Name: The name of the cell.

• ID: The id associated with the cell.

• Electrical Type: The electrical properties associated with the cell.

• Netlists: The number of nets in the transistor netlist (if the cell has a transistor netlist).

• Section: Indicates whether or not the cell is a section.
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3.8.6 Reference Cells

These reference cells can be imported into any project, for usage such as cell identification. It is useful in situations
where a series of parts are being reverse engineered, and they have similar, unique cells. You can export the cell you
identified to the ref library from one project, and then import it into another project. That way, you only have to do
the work once. You can build up a library of common cells for the devices you’re using. The reference cell library is
in the process of being replaced by the new cell identification feature.

3.8.7 Show Netlist Properties

When clicking the Show Netlist Properties button, 3 options become available: Netlist Text, Schematic, and
Truth Table.
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Shows the user the functional verilog, component verilog, H functional verilog, Spice, VHDL, and Comma-seperated
values.
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Shows the schematic of the cell.
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Shows the truth table of the cell.

3.8.8 Move Into Target Netlist

When this button (green down arrow) is pressed, it will take the user to the highlighted cell.

3.8.9 Move Out to Main Netlist

When this button (green up arrow) is pressed, it will take the user to the cell that is higher up than the cell that is
already targeted.

3.8.10 Manage Electrical Models

3.8.11 Electrical Properties

Here’s a little bit about electrical properties.
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No Type

This is the default state for all new cells. Hierarchical cells that contain other components will have this state. It has
no properties.

Resistor

<Add image of a resistor component>

Length: <Add definition>

Width: <Add definition>
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Sheet Resist: <Add definition>

(All Types)

𝑠ℎ𝑒𝑒𝑡𝑅𝑒𝑠𝑖𝑠𝑡 =
𝑤𝑖𝑑𝑡ℎ

𝑙𝑒𝑛𝑔𝑡ℎ
× 𝑡𝑜𝑡𝑎𝑙𝑅𝑒𝑠𝑖𝑠𝑡

Total Resist: <Add definition>

(All Types)

𝑡𝑜𝑡𝑎𝑙𝑅𝑒𝑠𝑖𝑠𝑡 =
𝑙𝑒𝑛𝑔𝑡ℎ

𝑤𝑖𝑑𝑡ℎ
× 𝑠ℎ𝑒𝑒𝑡𝑅𝑒𝑠𝑖𝑠𝑡

Capacitor
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<Add image of a capacitor component>

Length: <Add definition>

Width: <Add definition>

Unit Capacitance: <Add definition>

(MIM)

𝑢𝑛𝑖𝑡𝐶𝑎𝑝𝑎𝑐𝑖𝑡𝑎𝑛𝑐𝑒 =
𝑡𝑜𝑡𝑎𝑙𝐶𝑎𝑝𝑎𝑐𝑖𝑡𝑎𝑛𝑐𝑒

𝑙𝑒𝑛𝑔𝑡ℎ× 𝑤𝑖𝑑𝑡ℎ
× 1.0× 10−15

(Dual MIM)

𝑢𝑛𝑖𝑡𝐶𝑎𝑝𝑎𝑐𝑖𝑡𝑎𝑛𝑐𝑒 = (
𝑡𝑜𝑡𝑎𝑙𝐶𝑎𝑝𝑎𝑐𝑖𝑡𝑎𝑛𝑐𝑒

𝑙𝑒𝑛𝑔𝑡ℎ× 𝑤𝑖𝑑𝑡ℎ
) + (𝑙𝑒𝑛𝑔𝑡ℎ× 2.0) + (𝑤𝑖𝑑𝑡ℎ× 6.0))× 1.0× 10−15

(DCAP)

𝑢𝑛𝑖𝑡𝐶𝑎𝑝𝑎𝑐𝑖𝑡𝑎𝑛𝑐𝑒 =
𝑡𝑜𝑡𝑎𝑙𝐶𝑎𝑝𝑎𝑐𝑖𝑡𝑎𝑛𝑐𝑒

𝑙𝑒𝑛𝑔𝑡ℎ× 𝑤𝑖𝑑𝑡ℎ
× 1.0× 10−15

Total Capacitance: <Add definition>

(MIM)

𝑡𝑜𝑡𝑎𝑙𝐶𝑎𝑝𝑎𝑐𝑖𝑡𝑎𝑛𝑐𝑒 = 𝑤𝑖𝑑𝑡ℎ× 𝑙𝑒𝑛𝑔𝑡ℎ× 𝑢𝑛𝑖𝑡𝐶𝑎𝑝𝑎𝑐𝑖𝑡𝑎𝑛𝑐𝑒× 1.0× 10−15

(Dual MIM)

𝑡𝑜𝑡𝑎𝑙𝐶𝑎𝑝𝑎𝑐𝑖𝑡𝑎𝑛𝑐𝑒 = ((𝑤𝑖𝑑𝑡ℎ× 𝑙𝑒𝑛𝑔𝑡ℎ) + (𝑙𝑒𝑛𝑔𝑡ℎ× 2.0) + (𝑤𝑖𝑑𝑡ℎ× 6.0))× 𝑢𝑛𝑖𝑡𝐶𝑎𝑝𝑎𝑐𝑖𝑡𝑎𝑛𝑐𝑒× 1.0× 10−15

(DCAP)

𝑡𝑜𝑡𝑎𝑙𝐶𝑎𝑝𝑎𝑐𝑖𝑡𝑎𝑛𝑐𝑒 = 𝑤𝑖𝑑𝑡ℎ× 𝑙𝑒𝑛𝑔𝑡ℎ× 𝑢𝑛𝑖𝑡𝐶𝑎𝑝𝑎𝑐𝑖𝑡𝑎𝑛𝑐𝑒× 1.0× 10−15
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BJT

<Add image of BJT component>

Length: <Add definition>

Width: <Add definition>

Vth: <Add definition>

Area: <Add definition>

(All Types)

𝑎𝑟𝑒𝑎 = 𝑙𝑒𝑛𝑔𝑡ℎ× 𝑤𝑖𝑑𝑡ℎ
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MOSFET

<Add image of MOSFET component>

Length: <Add definition>

Width: <Add definition>

Fingers: <Add definition>

Vth: <Add definition>

Total Width: <Add definition>

(All Types)

𝑡𝑜𝑡𝑎𝑙𝑊𝑖𝑑𝑡ℎ = 𝑤𝑖𝑑𝑡ℎ× 𝑓𝑖𝑛𝑔𝑒𝑟𝑠

Source Length: <Add definition>
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Source Width: <Add definition>

Source Area: <Add definition>

(All Types)

𝑠𝑜𝑢𝑟𝑐𝑒𝐴𝑟𝑒𝑎 = 𝑠𝑜𝑢𝑟𝑐𝑒𝐿𝑒𝑛𝑔𝑡ℎ× 𝑠𝑜𝑢𝑟𝑐𝑒𝑊𝑖𝑑𝑡ℎ

Source Perimeter: <Add definition>

(All Types)

𝑠𝑜𝑢𝑟𝑐𝑒𝑃𝑒𝑟𝑖𝑚𝑒𝑡𝑒𝑟 = (𝑠𝑜𝑢𝑟𝑐𝑒𝐿𝑒𝑛𝑔𝑡ℎ× 2.0) + (𝑠𝑜𝑢𝑟𝑐𝑒𝑊𝑖𝑑𝑡ℎ× 2.0)

Drain Length: <Add definition>

Drain Width: <Add definition>

Drain Area: <Add definition>

(All Types)

𝑑𝑟𝑎𝑖𝑛𝐴𝑟𝑒𝑎 = 𝑑𝑟𝑎𝑖𝑛𝐿𝑒𝑛𝑔𝑡ℎ× 𝑑𝑟𝑎𝑖𝑛𝑊𝑖𝑑𝑡ℎ

Drain Perimeter: <Add definition>

(All Types)

𝑑𝑟𝑎𝑖𝑛𝑃𝑒𝑟𝑖𝑚𝑒𝑡𝑒𝑟 = (𝑑𝑟𝑎𝑖𝑛𝐿𝑒𝑛𝑔𝑡ℎ× 2.0) + (𝑑𝑟𝑎𝑖𝑛𝑊𝑖𝑑𝑡ℎ× 2.0)
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Inductor

<Add image of inductor component>

Outer Diameter: <Add definition>

Inner Diameter: <Add definition>

Number of Turns: <Add definition>

Inductance: <Add definition>

(Octagon)
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𝐴 = 1.07

𝐵 = 2.29

𝐶 = 0.0

𝐷 = 0.19

𝜇 = 4𝜋 × 1.0× 10−6

𝑑𝑎𝑣𝑔 =
(𝑜𝑢𝑡𝐷𝑖𝑎𝑚𝑒𝑡𝑒𝑟 + 𝑖𝑛𝐷𝑖𝑎𝑚𝑒𝑡𝑒𝑟)

2.0

𝜌 =
(𝑜𝑢𝑡𝐷𝑖𝑎𝑚𝑒𝑡𝑒𝑟 − 𝑖𝑛𝐷𝑖𝑎𝑚𝑒𝑡𝑒𝑟)

(𝑜𝑢𝑡𝐷𝑖𝑎𝑚𝑒𝑡𝑒𝑟 + 𝑖𝑛𝐷𝑖𝑎𝑚𝑒𝑡𝑒𝑟)
× 1.0

𝑖𝑛𝑑𝑢𝑐𝑡𝑎𝑛𝑐𝑒 = 𝜇× 𝑛𝑢𝑚𝑇𝑢𝑟𝑛𝑠2 × 𝑑𝑎𝑣𝑔 ×𝐴× (log(
𝐵

𝜌
) + (𝐶𝜌) + (𝐷𝜌2))

Diode
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<Add image of diode component>

Length: <Add definition>

Width: <Add definition>

Number of Anodes: <Add definition>

Area: <Add definition>

(All Types)

𝑎𝑟𝑒𝑎 = 𝑙𝑒𝑛𝑔𝑡ℎ× 𝑤𝑖𝑑𝑡ℎ

Unit Capacitance: <Add definition>

(All Types)

𝑢𝑛𝑖𝑡𝐶𝑎𝑝𝑎𝑐𝑖𝑡𝑎𝑛𝑐𝑒 =
𝑡𝑜𝑡𝑎𝑙𝐶𝑎𝑝𝑎𝑐𝑖𝑡𝑎𝑛𝑐𝑒

𝑙𝑒𝑛𝑔𝑡ℎ× 𝑤𝑖𝑑𝑡ℎ× 𝑛𝑢𝑚𝐴𝑛𝑜𝑑𝑒𝑠
× 1.0× 10−15

Total Capacitance: <Add definition>

(All Types)

𝑡𝑜𝑡𝑎𝑙𝐶𝑎𝑝𝑎𝑐𝑖𝑡𝑎𝑛𝑐𝑒 = 𝑤𝑖𝑑𝑡ℎ× 𝑙𝑒𝑛𝑔𝑡ℎ× 𝑛𝑢𝑚𝐴𝑛𝑜𝑑𝑒𝑠× 𝑢𝑛𝑖𝑡𝐶𝑎𝑝𝑎𝑐𝑖𝑡𝑎𝑛𝑐𝑒× 1.0× 10−15
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ROM

This cell type is used to denote an area that contains bits for memory extraction. It has no properties.

3.9 Netlist

3.9.1 Netlist Window

Before proceeding with netlisting, the technology for the layers needs to be set. see Technology
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The Netlist window shows all of the nets that have currently been found. Every time that polygons and cells (that are
part of a netlist) are updated, Pix2Net automatically updates the Active Nets.

The left window contains the list of nets. Here are the columns:

• ID: The ID number of the net.

• Name: The name of the port.

• Ports: The number of ports in the net.

• Polygons: The number of polygons in the net.

• State: A green checkmark indicates no errors. A red x indicates at least one error.

• Type: Shows the type of net, internal or external.

• Error: A short description of the net’s error.

If you click on a row, then the camera will zoom to the net and highlight it, and the right window will show the details
of the selected net.

The right window contains the list of ports for the currently selected net. Here are the columns:

• Cell ID: The ID number of the port’s cell.

• Cell: The name of the port’s cell.

• Instance: The name of the port’s instance.

• Port: The name of the port.

• Layer: What layer the port is on.

• Type: The port type: Input, Output, Inout, VSS, VDD, or Gate.

If you click on the right column, then the camera will zoom to that particular port.
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3.9.2 Netlist Checker

The Netlist Checker runs a series of sanity checks on the main netlist and makes a report of any errors encountered.

The checker can be configured to run the following tests:

• Check instance consistency: Verifies that the netlist of each instance of a cell matches the primary instance
netlist. This will compare the instances of all checked cells in the right hand pane and will report a match to a
different, checked cell if there is an inconsistency.

• Check database consistency: Verifies that the netlist does not have any missing entries in the database that could
cause problems or inconsistencies in the netlist. Run this periodically if database inconsistencies or corruption
are suspected.

• Check polygon connectivity: Verifies that the polygons are connected and can send energy from one layer to the
next.
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CHAPTER

FOUR

STEP-BY-STEP GUIDES

4.1 Schematic Tool Basics

After creating a netlist, the user may create a schematic by following the steps below:

If you have netlisted a library cell, such as a DFFR, you can view the schematic when that netlist is active (has a star
by the name in the ‘Project Cells’ window):

Highlighting the cell in the ‘Project Cells’ window will take the user to the cell in the overlay:
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Clicking on the ‘Show Schematics’ button on the ‘Schematic’ tab will bring up the schematic in the center
pane:
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Note:The schematic is initially rendered in the ‘auto layout’ mode. The work done in auto layout mode, i.e. rearranging
the cells and output ports, is not saved when you close the window.

Right click in the Schematic and hover the mouse over ‘Schematic mode’ and click ‘Manual layout’

Right click again in the Schematic to bring up the context menu:

4.1. Schematic Tool Basics 339



Pix2Net Documentation, Release 1.10.07

By clicking on ‘Place components using physical locations’ (after the schematic is in manual mode), the schematic
will be reorganized to reflect the physical layout. This is especially useful for the library cell level and the analog case:

Click on a desired net, cell or port in the schematic window to select it. (Make sure the ‘select’ button is highlighted
yellow). You will see the same object highlighted in the overlay.

Here is the overlay and schematic with a net highlighted:
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Here is the overlay and schematic with a cell highlighted:
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Here is the overlay with the ‘D’ port highlighted:

4.1.1 Larger Schematics

When you open a larger schematic, it will look more like this:
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In general, the inputs are in the bottom left edge and the outputs are to the right edge. From here, it is recommended
that the user right clicks in the window and sets the schematic mode to ‘manual layout’.

Zoom in to a closer view of the components, and select one (so it turns blue). Right click to pull up the context menu.
Select Edit component.
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The Edit Cell Instance window will appear:

Once you select a desired symbol, all of the cell instances are updated to reflect the change. Here you see the inverter
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symbol:

Select a group of related cells. They will all highlight in blue. Right click and select Move components to new block
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Now the components are in one hierarchical block in the schematic:

Now click on the Block Creator in the Schematic Tab, check only the block that was just created, and switch
your view to the overlay.

The corresponding cells are highlighted (in this case in a pink color) so the user can visualize the hierarchy.
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CHAPTER

FIVE

RELEASE NOTES

5.1 Change Log
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CHAPTER

SIX

GLOSSARY

anchor A holding point between two layers to stretch and shrink them in order to stack layer images on top of each
other for connectivity. Or, in the layer orthogonal case, an anchor is made to tell Pix2Net how the vertical and
horizontal axes should be defined.

cell Pushes the electric current between metals and vias from positive to negative.

feature extraction The process of converting images into polygons.

image layer A set of images that show a device layer.

multiscale images A set of images that show a device layer at multiple zoom levels. Multiscale images are time
consuming to generate, but they are essential for rendering image layers efficiently as the user zooms in and out.

netlist Shows the connectivity in the electrical circuit through polygon layer connections (metal layer to via to metal
layer).

neural network A network that extracts polygons by looking at images that the user specifies and then looks through-
out the layer while learning what should be considered part of the polygon layer, and what should not.

polygon layer A set of polygons that models a device layer.

schematic Shows a diagram of the electrical circuit.

SEM A scanning electron microscope.

stage A nanometer-precision linear or rotation stage that can be used with a SEM.

stitch A feature that is used to connect overlapping images into one image by placing the overlapping portion top of
each other and moving them to make sure there is no warp between images.
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